
Tutorial: recording into a song (4 of 4)

"Follow Song" recording
Suppose you have a bunch of sections lined up end to end in the top row of the arrangement grid, and 
you want to record Clarinet takes for each section while you play the entire song. To do this, select 
“Follow Song” in the Record menu. When this feature is turned on, the record-enabled section will move 
to the next section in the top row of the arrangement grid as each section is encountered, as you play. 
Note, however, that in this case you are not recording a single take like you did when you recorded into 
the separate “Linear” section. In this case your notes go into the current take selected in each section, in 
turn, as it is encountered.

Type Alt-W-2 to bring the Arrangement window to the front again. The View popup menu in the graphic 
editing/notation window shows “My Song.” Make sure that “Follow Song” is checked in the Record menu 
and that the record button is on in the control palette. Just to give us something new to record, let’s add a 
player to the ensemble. Choose “Add Player” from the Setup menu and choose “Clarinet” from the Player 
Library Entry drop-down list, then click OK. You will see that a Clarinet player has been added in the 
ensemble palette, and that the Clarinet player is record-enabled. Now click the rewind and play buttons 
and play Clarinet notes while the first two “Verse” and “Chorus” sections play. This time, when the wiper 
is over the body of the first Verse section, the notes will go into the Verse and when the wiper is over the 
body of the first Chorus section, the notes will go into the Chorus. You may notice that as the wiper 
reaches the end of the Verse section and enters the Chorus section, the red bar in the arrangement 
window moves from the Verse to the Chorus, indicating that the record-enabled section has automatically 
changed for you. When the wiper reaches the beginning of the second Verse section, you will hear the 
Clarinet notes that you recorded in your pass over the first Verse section. Any new Clarinet notes that you
play will be overdubbed on top of the existing notes in the Verse. This is because the section “Verse” 
plays back in exactly the same way wherever it appears in your arrangement. 

If you want to make a Verse2 section that can be modified independently from the Verse section, do the 
following: Click on the second Verse section in the arrangement grid to select it and hit the delete key. 
Next, click once on the name “Verse” in the section list on the left side of the arrangement window (not on 
the first Verse section instance that is placed on the arrangement grid). Choose “Duplicate Section” from 
the Song menu. A section called “Verse Copy” appears at the bottom of the section list. Double-click on 
“Verse Copy” and type “Verse2” to rename it -- then hit the enter key. Drag out “Verse2” and position it in 
the hole on row 1 where the second instance of “Verse” used to be. Now you can make changes to 
Verse2 in your arrangement which will not affect the “Verse” section.

Once you have created a song you are not limited to recording into the song as a whole. You can double 
click on any section instance in the arrangement grid to view that section in isolation. Then you can record
into the section as described earlier in this tutorial and your changes will affect all songs that use the 
section.



The Player Library (3 of 4)

Designing your Player library
Resist the temptation to create one player template for each sound on your MIDI device. Instead, think of 
a player template as a category of instrument, such as brass, or even a more specific classification, such 
as piano. Player templates are useful for making players that are more or less what you’re after. No doubt
once a player is created you will want to refine it to suit your piece. For example you should probably only 
have one “Piano” player template that can be used to create players that will actually become grand 
piano, honky tonk piano, or harpsichord. On the other hand, if you are constantly using a Fender Rhodes 
keyboard sound, then it would, for convenience sake, make sense to add a Fender Rhodes player 
template. It’s up to you to create a Player Library that fits the way you work.



Add Button
Click the Add button to add a device to the list.



Setup Menu
Add Player
Adds a single player of your choice to your document. You can choose any player template from the 
Player library. If the library doesn’t have exactly the type of player you want, just pick one that’s close and 
change it after it’s created.



Working with text (6 of 7)

Adding a part name to all parts
To add a part name to all parts that automatically shows the correct instrument name:

1. Make sure only a single player is currently visible.

2. Make a text box by selecting the Text Tool and clicking on the page where you want the text to appear.

3. Choose the Insert Part Name command from the Text menu.

3. You should see the name of that player appear in the text box.

5. Select the part name by clicking to the left or right of it inside the text box and dragging across the name.

6. Make font, size, and style selections from the Text menu to set the appearance of the part name.

7. Finally, choose a setting other than This Page Only from the pages menu.

For example, if you want the text to appear on the first page of each part, choose First Pages. You 
may want to repeat this process a second time with a different Pages setting; it is common to show 
the part name in large letters on the first page of each part, and in smaller letters on subsequent 
pages.

8. Press the enter key to exit the text box.



Working with text (7 of 7)

Adding page numbers
To add page numbers:

1. Make sure no text is selected by clicking on empty space with the arrow tool.

2. Select Center from the justify menu. 

3. This will help to automatically align the text box you are about to insert.

4. Select the text tool by clicking on the Text button at the top of the main window.

5. Click on the page at the height you want the text to appear. 

6. FreeStyle will create a text box centered on the printable area of the page with a blinking cursor right in the middle.

7. Choose a font, size, and style for the page numbers from the Text Menu.

8. Choose Insert Page Number from the Text menu.

9. Select All Pages from the Text menu.

10. Press the Enter key to exit the text box.



Additional FreeStyle Topics 
Overview
The topics below are additional topics not covered in the Basics section of this on-line help. These are all 
of the tasks in FreeStyle that are not crucial to basic recording and playback of your music. But they are 
things you will find extremely useful and helpful in your music-making.

Working With Text
Page Layout
Controllers
Playback Loops
Using the Metronome
Using Remote Controls
Copying and Pasting
Transposing
Quantizing
The Move Palette
The Player Library
The Ensemble Library
Preferences
Making your own metronome riff
Synchronizing FreeStyle
Opening standard MIDI files



Record Menu
Advance Record Loop
Makes the Record Loop jump ahead to the next range of measures. For example, if the Record Loop is 
currently looping measures 1 through 4, advancing it will make it jump to the next four bars, measures 5 
through 8. If you are currently viewing a song and the Record Loop matches the boundaries of a section, 
it will advance to the boundaries of the next section. The Advance Record Loop command is disabled 
when the Record Loop is turned off. To turn on the Record Loop, choose Toggle Record Loop from the 
Record menu, or press CtrlL.



Playback loops (2 of 9)

Advantages of playback loops
Using a playback loop has a few benefits. First, it saves time. You don’t have to copy and paste your one 
bar of drum notes many times to get the effect you want. Secondly, it saves memory in the computer. It 
takes less space to store one bar of notes with the directions to repeat those notes ten times than it does 
to store ten identical copies of the notes. Thirdly, it’s convenient to edit. When you change a note that is 
part of a playback loop, the note will change for all repeats of the note as well.



Alesis    
Quadrasynth and S4
FreeStyle puts the QuadraSynth/S4 into Mix mode automatically. For best results, you should refrain from
taking the QuadraSynth/S4 out of this mode while using FreeStyle. There is no way to choose from which 
bank, user or preset, a program is recalled when FreeStyle sends a program change message. 
Therefore, you will need to manually switch the QuadraSynth/S4 to the desired bank, user or preset, 
before selecting a program name from the popup patch list. There are multiple possible default patch lists 
for the QuadraSynth/S4. This is because different version of the QuadraSynth/S4 ROM contained 
different factory-installed programs. The current list installed is for ROM v 1.07. Contact Mark of the 
Unicorn technical support if you have an older ROM version and want the matching default patch lists.



Preferences (5 of 16)

Animate Piano
Causes the keys on the pitch ruler in the Graphic Editing window to highlight when a note of that pitch is 
played or recorded.



Setup Menu
Apply to “Player”
Applies a Player Library Entry’s settings to the currently selected player in the Ensemble window (or the 
record-enabled player if several players are selected). Just choose the desired replacement from the pop-
up menu in the dialog box as shown below.



Window Menu
Arrangement Window
The arrangement window for the currently open document displays the songs that have been created in 
the document. If multiple documents are open at the same time, each one is followed in the list by its 
Arrangement window.



Preferences (6 of 16)

Audible Note Editing
Causes notes to play when you click them and drag them.



Quick-Start Guide (5 of 6)

Auditioning Players
Now you should check your players to make sure they have the correct instrument sound.

1. Audition several players by clicking their names and playing a few notes on your MIDI keyboard.

Does the sound you hear match the name of the player? For example, does the piano player sound 
like a piano? If you are using a General MIDI device, the answer is probably Yes. If so, you are ready
to begin using FreeStyle!

2. If you don’t hear the correct instrument sounds, open up the Ensemble palette to check the players’ sound 
assignments.

3. Click each player’s name, choose a sound from the sound menu that is appropriate for that player, and try playing a 
few notes again.

If you now hear the correct sound, choose Edit Player Library from the Setup menu. Choose each 
player from the Player pop-up menu at the top of the dialog box and select a sound from the Sound 
pop-up menu below.

4. If you still don’t hear the correct sound for the first player (or no sound at all), check the table below.

Problem or situation What to do

The Sound pop-up menu lets you 
choose sounds, but players don’t 
have an appropriate sound assigned 
to them yet.

See Setting Up Players for a non-General MIDI device.

The Sound pop-up lets you choose 
sounds, but it displays generic patch 
names such as “Patch-1, Patch 2” etc.

If you see generic sound names as described, it means 
that FreeStyle isn’t familiar with your MIDI instrument. But 
don’t worry. You can still use it with FreeStyle. All you have
to do is determine the MIDI program change (or “patch”) 
number that matches the sound you want in your MIDI 
device. Then just choose that number from the sound pop-
up list. Most MIDI instruments list their internal sounds by 
program change number in the manual. For more 
information, see What to do if you see a generic sound list.

You choose a sound by name, such 
as Piano, but you don’t get that sound
and instead get a different sound, 
such as a clarinet.

This probably means that your MIDI device is in the wrong 
mode, or its bank-select setting needs to be turned on. 
See Checking the settings in your MIDI device and then 
Exit FreeStyle and re-open it after you’ve made the 
necessary changes to the settings in your MIDI instrument.
You may also find it helpful to review the help topic 
General advice about setting up your MIDI device.

You see MIDI channels in the sound See What to do if you see MIDI channels instead of a 



pop-up menu instead of sounds. sound list.

You don’t hear any sound at all. Check cables, headphones, and volume settings. Make 
sure the instrument is properly set for multi-timbral 
operation as described in FreeStyle’s on-line help. Try 
playing the instrument directly, without FreeStyle. Can you 
hear it? If you can, but then you can’t when you run 
FreeStyle, you’ve probably got a MIDI communication 
problem. Does your MIDI interface have activity lights on 
it? Do they blink when you play your keyboard into 
FreeStyle? If not, do you have other MIDI software you 
could test as well?



Tutorial: recording into a section (6 of 14)

Auto Loop Record
Auto loop record causes FreeStyle to automatically sense when you have stopped playing after two 
measures and then automatically set up the record loop over the music you just recorded in.



Record Menu
Auto Loop Record
During recording, Auto Loop Record causes FreeStyle to automatically loop back to the beginning of your 
performance two bars after you stop recording. Just lift your hands off your MIDI keyboard and wait a 
couple bars. FreeStyle automatically returns to where you began recording and starts playing from there. 
It also turns on the Record Loop (if it isn’t already on) so that the section will continue looping until you 
stop playback with the main transports. FreeStyle also stays in record so that you can continue recording 
into the section if you’d like. Auto Loop Record is a checkable menu item. Check it to turn it on; uncheck it
to turn it off.



Preferences (4 of 16)

Auto Scroll
Causes windows to automatically scroll during recording and playback to follow the playback wiper. The 
playback wiper always moves, regardless of this option.



Preferences (15 of 16)

Auto-Select Controllers
The Auto-Select Controllers feature applies musical “intelligence” to MIDI data recorded into FreeStyle. 
When this option is checked, pitch bend, volume changes, and other aspects of the musical performance 
that consist of MIDI controller data in the controller pane are automatically “linked” to the notes that they 
affect. As a result, you can select move, cut, copy, paste and otherwise edit notes, and the controller data 
is automatically included with the notes. This means that you don’t have to worry about pitch bend or 
similar data; FreeStyle takes care of it automatically for you when you edit the notes. The example below 
shows how the pitch bend in the controller pane is selected when the note is selected.

When the Auto Select Controllers option is turned off, notes and controller data must be selected and 
edited separately.



Notation view (4 of 12)

Automatic instrument part transposition
When you display more than one player at a time in the Notation view, FreeStyle uses concert pitch for all
players. When you display one player by itself, FreeStyle automatically transposes the part according to 
standard practice for the instrument. For example, alto sax players are transposed to Eb. The Edit Player 
Info command in the Setup menu lets you choose how an individual player is transposed, as well as the 
amount of space needed between its staff and neighboring staves.



Transposing (3 of 6)

Automatic instrument transposition
Many Player Library Entries are preset to do an automatic instrument transposition in the notation view 
whenever a player of that type is displayed by itself. For example, choose “Edit Player Library” from the 
“Player Library” sub-menu in the Setup menu. Choose “Clarinet” from the “Player Library Entry” popup 
menu at the top of the dialog. In the box within the dialog labelled “Notation”, you will see that “Transpose 
Part” has been set to B flat. This is because a clarinet is a B flat instrument. A Clarinet part played in the 
concert key of C will be transposed up a full step to the key of D when the part is displayed or printed by 
itself. This type of transposition does not affect the pitch of a player at all, only the way that it is notated.



View Menu
Back
Zooming back brings the magnification back to the previous level you were using just before the current 
zoom level. This command lets you easily switch between any two zoom levels. Just zoom to one level, 
zoom to another level, and then use the Zoom Back command repeatedly to switch between the two. It’s 
also a convenient command to use right after zooming in to do a fine edit, to get you back to where you 
were. Zoom back restores the scroll position as well as the zoom level.



Synchronizing FreeStyle (3 of 8)

Beat clock ratio
Some manufacturers have begun to make devices which send 24 clock signals per beat (one click of the 
device’s metronome) instead of the standard 24 clocks per quarter note. This new method is very useful 
when there are meters which do not use the quarter note as the beat unit: 3/8, 5/16, etc. In 6/8, for 
example, there might be a metronome click every three eighth notes; in 4/1, the metronome would click 
once every whole note. If you were using a less common meter such as 5/32 or 3/16 + 4/16, using the 
quarter note as the timing base would not be very useful. Instead, use the 24 clocks per metronome click 
option.



Songs (3 of 9)

Building a song in the Arrangement window
To add sections to the song, drag them from the Section list on left into the grid on the right. You can add 
the same section as many times as you want. For example, the chorus section may appear four times in 
your song. So just drag it from the Section list into the grid four times and place the four copies where 
they should go. The four copies are called "instances" of the original section. If you change the original, 
they all change, too. This doesn’t have to be the case, though. If you want to make a copy that is different,
use the Duplicate Section command to make a copy of the original, and then modify the duplicate section.

You can freely drag sections around in the Arrangement grid. Place sections in any row you wish; 
sections placed above or below one another play at the same time. If you place a section between two 
other back-to-back sections, FreeStyle automatically moves them to squeeze in the new section. Sections
in the same row cannot overlap. To overlap them, place them in different rows.



Tips & troubleshooting (6 of 12)

Can’t open FreeStyle
Try removing the FMSPREFS file from the FREEMIDI directory, which should be located in your Windows
directory. 



Tips & troubleshooting (2 of 12)

Can’t access the right sounds in your MIDI device
If you are having trouble getting FreeStyle to call up the right sounds on your MIDI instrument, there may 
be one or more settings that you need to make in the instrument so that it responds properly to FreeStyle.
For detailed information about your MIDI instrument, see How to set up your MIDI instrument for 
FreeStyle.



Window Menu
Cascade
This command places all of the currently open document windows on top of each other with every title bar
visible (in the standard Windows fashion) so that you can conveniently access any window.



Graphic Editing view (5 of 13)

Changing a note's duration
To change durations, hold the cursor near the end of a note (or one of several selected notes) until you 
see this hand. Then click and drag.



Notation view (7 of 12)

Changing a note's duration
Click near the end of the note to change duration. If it is a tied note, click near the end of the last tied 
note.



Graphic Editing view (6 of 13)

Changing a note's pitch
To change pitch, drag notes up or down. To change their time, drag them left or right. This works with a 
single note, as well as with a group of selected notes.



Notation view (5 of 12)

Changing a note's pitch
Drag the note up and down to change its pitch.



The Ensemble Palette (6 of 14)

Changing a player name
Double-click a player's name in the Ensemble palette to change it.



The Ensemble Palette (11 of 14)

Changing a player's color or pattern
To change a player's color or pattern, double-click the show button.



The Ensemble Palette (12 of 14)

Changing a player's volume and pan settings
Use the volume and pan controls by either typing in a value or by dragging the pop-up controls as shown. 
You can also draw changes in volume and panning over time in the controller pane.

                        



Transposing (5 of 6)

Changing key signature without transposing pitch
Suppose you just recorded a piano part in the key of D, but when you look at the notation view you see 
that it was written in the key of C. The pitches are correct, but the notation view doesn’t know what key 
you want. To fix this, click on the treble or bass clef symbol at the left edge of any staff (you’ll know you’re 
in the right place when the cursor changes to a “#/b” symbol). A popup menu of all the possible key 
signatures will appear. Choose the appropriate key signature and the notation view will update its 
transcription of your recording.



Songs (5 of 9)

Changing section lengths in the Arrangement grid
To lengthen and shorten sections in the Arrangement grid, drag their right edges.



Working with text (4 of 7)

Changing the font, size, style, etc.
You can change the font, size, and style of any selected text (including automatically generated measure 
numbers, staff names, and section names) using the settings in the Text menu.



Sections (3 of 6)

Changing the length of a section
Sections can be of any length. They are initially given a length of four bars, but if you record past the end 
of a section, it will grow to accommodate the notes you play in. If the section has been placed in a song 
and it butts up against another section, FreeStyle won’t automatically grow the section any more.

To adjust the length of a section, drag the heavy, black double-lined vertical end bar displayed in the 
Graphic Editing window in the note grid. You can also adjust its length anywhere it appears in the 
Arrangement window grid: just grab the right edge of the section and drag it.



Notation view (11 of 12)

Changing the magnification in the notation view
Choose a magnification from the magnification pop-up menu to reduce or enlarge the display. You can 
also zoom in on a particular area by Ctrl-dragging over it. To get back to normal size, choose Zoom 
Normal from the View menu.



Page layout (8 of 10)

Changing the spacing between staves
You can use the Edit Player Info command (Setup menu) to change the way staves are spaced. This is 
the only aspect of your page layout that is the same for parts and scores. The piano setting in the clef 
pop-up menu gives the player two staves, with bass and treble clefs. All the other choices result in a 
single staff for the player. The ledger line settings in the window control how much space is needed 
around this player's staff or staves, expressed as a number of ledger lines (equal to the space between 
two staff lines). When working with a two-staff player (“Piano” clef), the setting called ledger lines between
controls how much space appears between the player's two staves.



Page layout (7 of 10)

Changing the staff size
There are two ways to affect the size of the music that FreeStyle will print. If you use the staff size setting 
in the Page Layout dialog, FreeStyle will show you the page the way it would print. This method affects 
only the size of your music, leaving staff names and other text unchanged. Since your printer probably 
has higher resolution than your computer monitor, you may choose a staff size that is too small to view 
comfortably on your screen. If so, you can use the zoom setting in the lower left of the Notation View to 
zoom in on the staves.

The other way to change the size of the printed music is to choose a scaling setting in the Print Setup 
command Options dialog box. If you want everything to be 80% of normal size, type in 80%. Since the 
size of the paper in your printer doesn’t change, FreeStyle changes the size of the white page area in the 
notation display so that after scaling, it will correspond to the actual page size. This method scales 
everything that FreeStyle prints, so all text, section names, measure numbers, etc. will come out at 80% 
of normal size. Also any text you’ve placed on the page in a specific relation to the margins will probably 
need to be repositioned after you change the scaling amount.



Quick-Start Guide (2 of 6)

Checking The Settings In Your MIDI Device
Before you proceed further, click the manufacturer of your MIDI playback device below. These help topics,
listed by manufacturer, tell you how to make crucial settings in your MIDI instrument that allow FreeStyle 
to initialize the instrument. Doing so lets you access the device’s sounds as easily as possible from within 
FreeStyle. It is best to do this before you launch FreeStyle for the first time.

>> If you have a sound card, you can skip this step.

If your MIDI device is not listed, read the section called “General advice about setting up your MIDI 
device”. It will help you figure out how to best set up your instrument for use with FreeStyle.

After you jump to one of the topics below, click the "Return to Quick-Start Guide button (shown below) to 
jump back here.

 
Alesis
E-mu Systems
Ensoniq
Kawai
KORG
Kurzweil
Roland
Yamaha

General advice about setting up your MIDI device



The Ensemble Palette (7 of 14)

Choosing a playback sound for a player
To choose a sound for a player, click in the "Sound" column in the Ensemble palette on the same line as 
the desired player.    The sounds you see in the resulting pop-up menu are the sounds available in your 
MIDI synthesizer(s).



Choosing what to record into (3 of 5)

Choosing a player
Click the record button next to the player's name to record-enable it.



Choosing what to record into (2 of 5)

Choosing a section in the Arrangement grid
Another way to choose a section for recording is to click it in the Arrangement grid.



Choosing what to record into (4 of 5)

Choosing a take
Choose a take for the player by selecting it from the Take pop-up menu next to the player’s name. You 
can record into a new take by choosing new from the take pop-up menu. You can also record into an 
existing take, even if it already has music in it. FreeStyle will just add the new music you record to what is 
already there.



Graphic Editing view (13 of 13)

Choosing a time signature (meter)
To choose a time signature (meter) for your song, press on the meter pop-up menu shown here. It's 
located in the upper left-hand corner of the Graphic Editing/Notation view.



Controllers (3 of 7)

Choosing a type of controller to work with
Choose the type of controller you want to work with from the Type pop-up menu as shown here.



Choosing the current section or song (1 of 1)

The current section or song is the one you are listening to, viewing, and recording into in the Arrangement
and Graphic Editing/Notation windows. Most of the commands in the Song menu affect the current 
section or song.    If you are currently viewing a song, then there is also a "record-enabled section" within 
that song.    If you are currently viewing a single section, then that section is also the record-enabled 
section.    In FreeStyle, use these popup menus to always be aware of which section or song you are 
working on:

> "View:" popup menu in the Graphic Editing/Notation Window -- allows you to choose either 
a song or a single section for viewing.    Sections are listed first.

> "Song:" popup menu in the Arrangement Window -- allows you to choose a song.    The 
song will be shown in both the Arrangement Window and the Graphic Editing/Notation 
Window.

> "Section:" popup menu in the Ensemble Palette --    this popup menu is active only when 
you are viewing a song.    When you choose a section here, the section you choose 
becomes the record-enabled section, and the Take column in the Ensemble Palette shows 
the current take number for each player in that section.    Another way to do the same thing 
is to click on a section instance in the Arrangement Window's layout grid.



Choosing what to record into (1 of 5)

Choosing what to record into
One way to choose a section for recording is to select it from the View pop-up menu.



Edit Menu
Clear
Removes the selected items. Anything that can be selected can be cleared. As an alternative to choosing 
clear from the Edit menu, you can press the delete (backspace) key on the keyboard. Clear differs from 
Cut in that it does not place the cleared material on the Clipboard.



File Menu
Close
The Close command closes the currently open window. If several windows are open, it closes the window
that is currently in front. Closing a document’s main window (the window containing the graphic editing 
and notation views) also closes the document. If the document you want to close is not in front, click on its
main window.



Quick-Start Guide (6 of 6)

Congratulations!
You’ve completed your FreeStyle installation and are ready to begin making music. For more information, 
see the topics in FreeStyle Help Contents.

For more information:

FreeStyle On-Line Help Contents



Connecting a MIDI Controller 
To record music into FreeStyle, you need an electronic keyboard synthesizer or other MIDI controller. 
There are several ways a MIDI controller could be connected to your computer, depending on your 
hardware. Below are several of the most common ways:

Figure 2:    Several common ways to connect a MIDI controller.



FreeStyle Help Contents
READ THIS FIRST! FreeStyle Quick-Start Guide

FreeStyle Basics

Additional FreeStyle Topics

FreeStyle Tutorials

FreeStyle Menus

Tips and Troubleshooting

Keyboard shortcuts

How to set up your MIDI instrument for FreeStyle



Edit Menu
Controller Preferences
The controller preferences affect the way that FreeStyle handles MIDI conintuous controller data.



Controllers (1 of 7)

Overview
The word "controller" is shorthand for the MIDI term “continuous controller data”, which is a type of MIDI 
information. Continuous controllers are used to add musical effects that change smoothly over time, such 
as volume changes (crescendos & decrescendos), amount of vibrato (which often increases in intensity 
over the duration of a note), and pitch bend to name a few. There are over a hundred types of controllers, 
although only about 30 are commonly used. In most cases, controllers affect whatever notes are playing 
at the time that they occur. In addition, they usually consist of a stream of individual data events that 
change their value over time. For example, a crescendo that occurs over the period of one bar might 
actually consist of 50 or 60 individual volume control MIDI events spaced only a few fractions of a second 
apart. In addition, each one has a value that is a little higher than the one before it (controllers have a 
value range from 0 to 127). To our ears, the net effect sounds like a smooth crescendo.

Since Controllers have this dual nature (individual events that constitute a smooth gesture) FreeStyle 
displays them in a way that lets you see where each event is, as well as the overall shape. Whenever you
see a bracket in the controller view it indicates that there is a single event in effect for the entire duration 
of the bracket.

Note velocities (the “velocity” of a note determines how loud it is) are the one exception to the way that 
controllers are displayed. Since there is only one velocity setting for each note, they are drawn as vertical 
bars, rather than as a connected shape.

Drawing controllers in the controller grid
Choosing a type of controller to work with
Selecting controllers for editing
Drawing straight line effects and smooth curves
Working with note-on velocities
FreeStyle is intelligent about editing controllers with notes



View Menu
Controllers
When this menu item is checked, the MIDI controller strip appears at the bottom of the Graphic Editing 
window. The Controller strip lets you view, insert, and edit MIDI controller data, which produces musical 
effects such as pitch bending, continuous volume changes, panning, chorus and effects depth, sustain 
pedal, pitch modulation, and more. The strip can display any type of controller data for any player, and it 
can show data for multiple players at a time (i.e. volume for all players at once), although it only shows 
one type of data at a time (i.e. volume or pitch bend, but not both).



Edit Menu
Copy
Makes a copy of the selected music or text and places the copy on the Clipboard, from which it can be 
pasted with the Paste command.



Copying and Pasting (1 of 6)

FreeStyle has standard Windows cut, copy, and paste commands in the Edit menu. These simple 
features give you an amazing amount of control over your music. You can “slice and dice” your music in 
much the same way that you can rearrange text in a word processor. You can use copy and paste to 
move music around or make repeating variations on a figure. And since FreeStyle lets you work with 
multiple documents at the same time, you can even copy bits from one piece of music into another.

Cut and Copy
Paste
Determining which player to paste into
Pasting music into multiple players
Pasting into a song



Region Menu
Create Play Loop
A play loop is a region of material that repeats itself within the section for as many times as you specify. 
The Create Play Loop command creates a play loop out of the currently selected material. If nothing is 
selected, then the measure containing the playback wiper becomes the source measure for the loop. For 
your convenience, FreeStyle automatically figures out how many repeats are necessary to make the loop 
play for the entire length of the section.

The benefit of creating a play loop instead of just copying and pasting by hand is that if you make a 
change to the original material, the change is automatically reflected in all iterations of the loop. You can 
even make modifications to iterations within a play loop (called overrides) so that the loop doesn’t sound 
exactly the same each time it repeats. 



Playback loops (5 of 9)

Creating a playback loop
To create a playback loop for a player, first record-enable the player that you want to loop and select the 
take which you want to affect. Then switch to the graphic editing view by clicking on the graphic editing 
button and use one of the following two methods:

> Looping the selected notes: with the arrow tool, drag a selection box around the notes that 
you want to repeat. They will turn white to indicate that they are selected. Choose Create 
Play Loop from the Region menu. Loop markers will appear in the time line to indicate the 
beginning of the loop source material, the end of the loop source material, and the end of 
the last repetition of the loop.

> Looping the current measure: If any notes are selected, deselect them by clicking on empty
space in the graphic editing grid. Click in the time line to position the time wiper within a 
measure that you wish to contain the source material for the loop. Choose Create Play 
Loop from the Region menu. Loop markers will appear in the time line to indicate the 
beginning of the loop source material, the end of the loop source material, and the end of 
the last repetition of the loop.

If loop markers do not appear in the time line, try zooming time in with the zoom slider (magnifying glass) 
in the lower left of the editing window. Loop markers do not appear in the time line when you are zoomed 
way out and measure lines are very close together. If zooming doesn’t make them appear, then you have 
the wrong player selected or the wrong take selected.



Playback loops (8 of 9)

Creating a playback loop override
To create an override measure within an existing playback loop, first select the take that contains the loop 
and record-enable its player. Switch to the graphic editing view by clicking on the graphic editing button. 
Playback loop markers will appear in the time line. Then do one of the following:

> Manual override: Click in the time line to position the time wiper within the measure that you
wish to override. You must choose one of the repeating measures within the loop, not one 
of the loop source measures. Choose “Override Play Loop” from the Region menu. 

> Automatic override: With the record button on in the control palette, play new notes 
anywhere within the loop. If you play into the source measures of the loop, all repeats of the
loop will receive the new notes and no override will be created. If you play into a repeat bar 
of the loop, the new material appears only in that measure.

In either case above, a loop override marker will appear in the time line to indicate that the measure is 
now editable independently from the rest of the loop. Also, you will notice that all notes in the override 
measure (including the new ones you just played in) now have rounded edges to indicate that they are no
longer just repeating ghosts of previous notes.



Sections (2 of 6)

Creating a section
Creating a section is easy. Just choose New Section from the Song menu. FreeStyle asks you to name it. 
After you do so and click OK, the section appears at the bottom of the Section list in the Arrangement 
window. It also appears in the Graphic Editing/Notation window, empty and ready to be recorded into.



Songs (2 of 9)

Creating a song
Creating a song is easy. Just choose New Song from the Song menu. FreeStyle asks you to name it. 
After you do so and click OK, the song appears in the Arrangement window, as well as the Graphic 
Editing/Notation window. It is ready for you to place sections into it.



Region Menu
Custom
This quantize option matches the timing of all currently selected notes to an evenly spaced quantize grid. 
You choose the grid’s resolution from the note pop-up menu provided; most often, you’ll want to choose 
the resolution that matches the shortest duration you are quantizing. You can choose whether or not to 
include durations when quantizing with the Affect Durations check box. The Time offset slider lets you shift
all notes a little bit earlier or later than the grid locations themselves, which occur on exact beat divisions, 
creating either a pushed or laid back feel. The Swing slider lets you shift every other grid point to create 
jazz and hip-hop feels.



Quantizing (3 of 5)

Custom quantizing
Custom quantize, on the other hand, uses a fixed grid, but gives you complete control over it.

Notation based quantize is great when your playing is fairly exact, but you just want to tighten up the 
overall feel. Use custom quantize in situations where you want to alter or precisely control the rhythmic 
feel.



Edit Menu
Cut
Removes the selected music or text and places it on the Clipboard, from which it can be pasted with the 
Paste command.



Copying and Pasting (2 of 6)

Cut and Copy
The copy command places a copy of everything selected onto the clipboard. (Cut works the same, except
that the selected events are then deleted.) It stays on the clipboard until you copy something else. You 
can copy any selection of notes and controllers, even if there is more than one Player involved. This lets 
you move entire stretches of music in a single operation.

When you copy notes that are in a playback loop, only the source notes are copied to the clipboard; the 
notes generated by the playback loop (i.e. the notes in the playback loop with the squared-off edges) do 
not copy.

When you copy while viewing a song, a copy of the selection will be placed on the clipboard for each 
instance of its section in the current song. For example if I have put five copies of “Chorus” in my song, 
and I copy some music from “Chorus” I will wind up with five repetitions of the events on the clipboard. 
This may or may not be what you intended. In general it is less confusing and error prone to copy and 
paste when viewing a section.



Preferences (16 of 16)

Default controllers for pop-up
Lets you choose which controllers appear in the controller pop-up menu below the controller pane. Use 
the Add and Remove buttons to add or remove controllers from the pop-up list. All other controllers, 
unless they are present in the displayed takes, are accessed with the “other” item in the pop-up menu.



Delete Button
To remove a device from the list, click the device's icon to select it and then click the Delete button.



Setup Menu
Delete Player
Removes the currently selected player (or the record-enabled player if several players are selected) from 
your document. The player is removed from all sections, and all of its takes are discarded as well. This 
command doesn’t permanently get rid of the player from the Player library; it only removes the player from
the current document. To remove a player from the library, use the Edit Player Library command.



Song Menu
Delete Section
Gets rid of the section that you specify before choosing this command. To indicate which section you want
deleted, either click it in the Section List in the Arrangement window to select it, or choose it from the View
pop-up menu in the graphic editing or notation view to make it the current section. Deleting a section 
removes it from all songs in which it is used.



Song Menu
Delete Song
Gets rid of the song that is currently displayed in the Arrangement window, Graphic Editing window, or 
Notation display. If the window is currently showing a section instead of a song, the Delete Song 
command grays out to indicate that it is not available. To make it available, select a song from the pop-up 
menu. Deleting a song just removes the arrangement of sections, not the sections themselves.



Record Menu
Delete Take
Deletes the current take for the record-enabled player in the Ensemble window. For example, if you select
take 5 and then use Delete Take, take 5 completely disappears from the pop-up menu. 



Playback loops (6 of 9)

Deleting a playback loop
To delete a playback loop, select the take that contains the loop and show only that take’s player in the 
graphic editing view. Playback loop markers will appear in the time line. Click any loop marker other than 
an override marker and hit the delete key to delete the loop. When the loop is removed, all repeating 
notes will go away. The original source notes for the loop and all notes entered into override measures 
will remain.



Playback loops (9 of 9)

Deleting a playback loop override
To delete a playback loop override within an existing playback loop, first select the take that contains the 
loop and show only that take’s player in the graphic editing view. Playback loop markers will appear in the
time line. Click on the override marker in the measure that you wish to revert and press the delete key to 
delete the override. When the override is removed, the take will revert to playing and showing ghosts of 
the original looping notes (with square edges). It is important to note that deleting an override does not 
delete whatever extra notes were recorded within the override. If you override the measure again, those 
notes will appear again. If you want the notes in your override to be deleted as well, select them and 
delete them before you delete the override marker. 

When you add a playback loop to a take which contains existing notes beyond the end of the loop source,
the playback loop will act like an opaque layer on top of whatever notes were previously recorded. 
Repeating notes will temporarily obscure whatever used to be in the repeat bars until the playback loop is 
removed -- at which time the old notes will become visible again. When you override a playback loop in a 
given measure, it is like cutting a hole in the opaque layer and looking through to the raw take 
underneath. Hence, if you add a playback loop to a take which obscures a group of old notes, you may be
surprised to find them popping up in your override measures. To avoid this, delete unwanted notes from a 
take before adding a playback loop.



Details
Click the Details expand button to view further settings about the device.



Copying and Pasting (4 of 6)

Determining which player to paste into
If you only copied music from one player, the music will always be pasted into the record-enabled player, 
regardless of which player it was copied from.



Device Icon
Click the device icon to select the device for deleting or testing with the Delete or Test buttons at the 
bottom of the window.



Device ID
If you know what the MIDI system exclusive device ID is for the device, indicate it here. If you don't know 
it, don't worry about it.



Device Name
Type in a name for the device here.



Device Usage button
The Device Usage button lets you make various settings regarding MIDI devices in your computer, such 
as MIDI-equipped sound cards.



Tips & troubleshooting (9 of 12)

Disk Repairs
We are glad to replace damaged disks belonging to registered users. Please contact Mark of the Unicorn 
Technical support by phone, fax, e-mail, or letter, if your disk needs to be repaired or replaced. See 
Technical Support for information about how to contact Mark of the Unicorn.



Tips & troubleshooting (3 of 12)

Display seems to stall and skip
You may be running into the limits of your computer’s processing power. FreeStyle gives priority to 
sending and receiving MIDI data over most screen redisplays. However, with enough of an overload you 
may hear delays or erratic timing in your music. 

Usually the overload is caused by vast reams of aftertouch (mono or poly key pressure), controller, or 
pitch bend events in one or more synthesizer tracks.

To solve the problem, you must reduce the amount of MIDI information being sent by FreeStyle in one of 
the following ways:

> Slow down the tempo of the sequence during the problem passages. 

> Delete unneeded aftertouch or other controller data in the controller view. (See Controllers 
for more information.)

> Delete a track or tracks from the sequence.



Done Button
When you are finished with the Device Setup window, click Done, and you will proceed into FreeStyle.



Controllers (2 of 7)

Drawing controllers in the controller grid
Controllers are inserted, displayed, and edited in the controller grid, which appears right below the note 
grid in the Graphic Editing view. To display the grid, display the Graphic Editing view and then choose 
Controllers from the View menu, or press CtrlF11 instead as a shortcut. In FreeStyle’s controller grid, you 
can draw a single controller by clicking once with the pencil tool to achieve a sudden effect, or you can 
draw a smooth curve by dragging the pencil, line, and curve tools. When inserting controllers, you do so 
for one player at a time: the currently record-enabled player. So any time you draw controllers, first 
record-enable the player you want to edit.



Controllers (5 of 7)

Drawing straight line effects and smooth curves
The straight line tool lets you insert a straight line of controllers, which produces a smooth effect. Just 
click the line tool and then drag in the grid.

The Curve tool lets you draw curves and arcs. FreeStyle determines the curve shape to draw based on 
the direction in which you first start drawing. Initially drawing up or down makes one type of curve; 
drawing left or right makes another. Try it, you’ll quickly get the hang of it.



Song Menu
Duplicate Section
After choosing a section, you can use this command to make an exact copy of the section. The copy 
appears at the bottom of the section list with the word copy appended to the original name as shown 
below. The copy is completely separate; it is not “linked” or otherwise related to the original in any way, so
you can freely modify it without affecting the original section. Duplicating is useful when you want to use 
an existing section as a basis for new material.

It is not necessary to duplicate sections before adding multiple copies of a section to a song in the 
arrangement grid. Just drag in as many copies of a section as you want. Unlike the sections made from 
the Duplicate command, copies dragged into the arrangement grid are references to the original; this 
means that if you change the original, all instances of it in the song will change, too. If you want to make 
one instance of a section different from the others, make a copy of it using the Duplicate Section 
command.



Graphic Editing view (7 of 13)

Duplicating a note
To duplicate notes, hold down the Ctrl key while dragging.



Notation view (6 of 12)

Duplicating a note
Ctrl-drag a note to duplicate it.



Notation view (2 of 12)

Dynamic transcription
The notation display is dynamic: you can fully edit the music using the same conventions as graphic 
editing. Changes in either view are immediately reflected in the other. When you record, the staves 
immediately fill up with the notes you play as you record. Unlike other simplistic music software programs,
FreeStyle’s notation transcription is a sophisticated interpretation of the raw MIDI data you record. For 
example, if you play swing, turn on the Straighten Swing feature in the Setup menu (under the Notation 
menu item) and FreeStyle writes it using straight rhythms instead of triplets.



E-mu    
Proteus, MPS, Morpheus, Vintage Keys families
No specific preparations are necessary to use these devices with FreeStyle.



Edit Menu
This section provides specific information about each of the commands in the Edit menu.

Undo
Redo
Cut
Copy
Paste
Clear
Select All
Preferences
General Preferences
Recording Preferences
Notation Preferences
Controller Preferences



Setup Menu
Edit Notation Settings
Causes a window to appear where you can adjust all of the notation settings in the current document. To 
adjust these settings for all new documents, use the Preferences command.



Setup Menu
Edit Player Info
Lets you view and modify various settings for the currently selected player in the Ensemble window (or 
the record-enabled player if several players are selected). Although this dialog looks a lot like the Edit 
Player Library dialog, this one allows you to change a player’s settings only in the current document 
without changing the settings of any Player Library entry.



Setup Menu
Edit Player Library
Produces a dialog that lets you view the player library and make changes to it.



The Player Library (2 of 4)

Editing your player library
To edit your player library, choose Player Library from the Setup menu and choose Edit Player Library 
from the sub-menu.



Setup Menu
Ensemble Library
An ensemble is a group of player templates. The Ensemble library contains preset ensembles that you 
can use when creating a new document. The Ensemble Library menu commands let you create your own 
new ensembles, change existing ones, and add an ensemble to an existing document.

Edit Ensemble Library
Produces a dialog that lets you view the Ensemble library and make changes to ensembles.

Save Current Ensemble
Asks you to name the current ensemble in the Ensemble window and then saves it in the Ensemble 
Library. It also automatically adds the players in the ensemble to your player library.

Add Ensemble to this file
Adds the players from the ensemble of your choice to the Ensemble window. This command does not 
replace the current ensemble; it adds to it.



Ensoniq    
ESQ-1
For best results with FreeStyle, set up the ESQ-1 by setting the MIDI Basechannel to 1 and assigning 
each of Tracks 1-8 to MIDI channels 1-8. Also, set the MIDI Mode to be MULTI and Local Control OFF.

ESQ-M
For best results with FreeStyle, set up the ESQ-M by setting the MIDI Base channel to 1 and assigning 
each of Tracks 1-8 to MIDI channels 1-8. Also, set the MIDI Mode to be MULTI.

KS-32
For best results with FreeStyle, put the KS-32 into MULTI mode and SEQ/PRESET mode. Also, you 
should disable local control manually on the KS-32.      To do so:    Press the 'TRACK MIDI' button until you
come to 'SEND/RECV'. Use the DATA ENTRY Slider to set the parameter to 'LOCAL-OFF'. You will need 
to do this individually to each of the 8 Tracks.

TS-10
For best results, FreeStyle automatically puts the TS-10 into Multi-Mode. If SYS-EX is set to OFF, you 
should set it to ON before using it with FreeStyle. To do so press the MIDI Control button until you see the
page that displays 'SYS-EX = '. You should leave the TS-10 in Multi-Mode. Once in this mode, you should
make sure that each track is assigned______ a unique MIDI channel from 1-12. Note however that in 
Multi-Mode only the 'Sound Banks' are available. YOU WILL NOT HAVE ACCESS TO THE 'PRESET 
BANKS'.

Also, you should disable local control manually on the TS-10.    To do so:    Press the 'TRACK MIDI' button 
until you come to 'SEND/RECV'. Use the DATA ENTRY Slider to set the parameter to 'LOCAL-OFF'. You 
will need to do this individually to each of the 12 Tracks.

VFX SD
For best results with FreeStyle, set up the VFX by setting the MIDI Mode to be MULTI and Local Control 
OFF.



Record Menu
Erase Take
Removes all music from the current take of the currently record-enabled player in the Ensemble window.

Erase Take and Delete Take differ in that Erase Take just removes the contents of the take, whereas 
Delete Take removes both the contents and the take itself.



File Menu
Exit
Closes all open documents, exits FreeStyle, and returns to Windows. If an open document has unsaved 
changes, FreeStyle asks if you wish to save them before closing the file.



Expand Icon
Click the expand icon to tell FreeStyle about the device's MIDI connections.



File Menu
This section provides specific information about each of the commands in the File menu.

New
Open
Opening a standard MIDI file
Import Into Section
Close
Save
Save As
Save a Copy As
Revert to Saved
Print
Print Setup
Page Layout
Exit



Preferences (3 of 16)

File save updates Player Library
Causes changes you make to the players in the Ensemble window to be automatically saved in the Player
Library. If you don’t want your library entries to be changed automatically, don’t check this option.



Synchronizing FreeStyle (5 of 8)

First clock is time 1
When First clock is time 1 is checked, FreeStyle interprets the first MIDI clock signal it receives as the 
second timing clock of the sequence, 1/24th of a beat after the beginning. Devices manufactured recently 
send the first clock signal (time 0) after the start command for the sequence. Some earlier devices 
assume the start command to be the first clock signal. The first clock signal they send would be 1/24th of 
a beat after the beginning. If you are using one of these devices, you should check this option.

Since manufacturers rarely explain this aspect in their documentation, you may not know if your device 
behaves this way. The best way to find out is to experiment: set the metronome to the slowest possible 
tempo, play both devices (with FreeStyle as slave) and listen for discrepancies in attacks and beat 
alignment. The difference of 1/24th of a beat is very audible at a slow tempo. If FreeStyle seems slightly 
behind the master device, try checking this option.



Tutorial: recording into a section (8 of 14)

Follow Song
Follow song becomes available when the section you are recording into has been placed into a song in 
the Arrangement window. But since we haven’t done this in this tutorial, it is currently grayed out in the 
menu and you can ignore it for now.



Record Menu
Follow Song
FreeStyle lets you record into sections and also into songs. The Follow Song command affects the 
process of recording into a song.

Turning Off Follow Song
When it is turned off (unchecked), FreeStyle only records into the currently record-enabled section in the 
Arrangement window (indicated by a red bar as shown below). To make a section record-enabled, just 
click it.

As playback proceeds through the song, FreeStyle only drops into record when it reaches the record-
enabled section. If the section appears in the song more than once, FreeStyle drops into record each time
it reaches the record-enabled section. In the example above, recording would occur only when the verse 
plays at measures 8-17. (Note that this range includes the measure before and the measure after the 
section. That’s because each section has a “pickup” and “overhang” measure.) FreeStyle drops out of 
recording during sections that are not record-enabled (no red bar).

Turning On Follow Song
When Follow Song is turned on (checked), FreeStyle records into each section in the top row of the 
Arrangement Window as it plays. The top row is called the primary song structure row. Notice that the 
Verse section is record-enabled because it is currently playing (the scrolling playback wiper is in it). When
the wiper reaches the next section, Chorus, it will become record-enabled.

As you can see, the Follow Song feature lets you set up sections in a song before recording and then 
record into them continuously from one to the next. FreeStyle automatically places what you play in each 
appropriate section. You can easily go back and forth between this style of “linear” recording within a song
and loop-recording within a single section. The Follow Song feature gives you the best of both worlds.

Using Follow Song with Stationery
The follow song command can be used any time you wish to record without being concerned about what 
section you are in. It is ideal when used with FreeStyle Stationery files, which are song templates with 
sections already set up in them, ready for you to record into when you start a new document.



Text Menu
Fonts
The list of fonts in this dialog box are the fonts currently installed in Windows. To choose a font for some 
text, select the text and choose the desired font.



FreeStyle Basics
Overview
The sections below cover the basic tasks and features in FreeStyle that have to do with recording and 
playing back your music.

Graphic Editing View
Notation View
The Ensemble Palette
Sections
Songs
Choosing the current section or song
Showing and hiding players
Choosing what to record into



Controllers (7 of 7)

FreeStyle is intelligent about editing controllers with notes
Many sequencers treat notes and controllers completely separately, and they leave it up to you to 
remember to edit the controllers after you edit the notes they affect. For example, if you copy some notes 
that also have a crescendo, you’d need to remember to copy and paste the crescendo after doing so with 
the notes.

FreeStyle helps you out by automatically selecting controllers when you select notes by dragging a 
selection box over them. When you copy or modify the notes, the controller information will come along 
for the ride. FreeStyle decides whether or not to auto-select the controller information based on the 
amount of overlap that the selected notes have with the other notes around them. Since there are times 
when FreeStyle may not select controllers you want it to, or may select ones you don’t, you should keep 
the controllers view open if you are not sure what is happening. Also, if you find that you do not like the 
decisions that FreeStyle makes about when to select controllers, there is a preference to turn auto 
selection off.

FreeStyle also gives you a hand when it comes to pasting controllers. In other sequencers, when you 
paste controller information on top of other controller information, the events are simply merged together. 
This almost always yields horrible sounding results. FreeStyle takes a more intelligent approach. It looks 
at the controllers that are being merged together, and if there is a conflict it only keeps the controllers you 
are pasting. What you are pasting always takes precedence over the destination. In this way the notes 
that you paste will sound the same as when they were copied. (You can reverse this behavior by checking
the “keep destination controllers” preference.) 



FreeStyle Menus
The topics below provide help for each menu item in FreeStyle, and they are organized by their position in
the menus.

File Menu
Edit Menu
View Menu
Region Menu
Record Menu
Song Menu
Setup Menu
Text Menu
Window Menu



FreeStyle Tutorials
Overview
These tutorials take you step by step through the process of recording into a section and recording into a 
song.

Tutorial: Recording into a Section
Tutorial: Recording into a Song



Using the metronome (2 of 2)

FreeStyle’s “Riff” Metronome
FreeStyle’s “riff” metronome is probably one of the most musical metronomes you’ve ever encountered. A 
riff can be any musical phrase you want. FreeStyle provides a list of stock drum loops as riffs, but you can
make your own riffs out of anything, such as a bass part or keyboard lick. To use a riff, choose it from the 
pop-up menu as shown below. To add your own riff to the menu, either save it into FreeStyle’s metronom 
directory as a standard MIDI file using the Save As command, or select anything you’ve recorded into 
FreeStyle and use the Save As Metronome command in the Region menu. Then start jamming. Once 
you’ve got some ideas down, you can convert the metronome riff into a player using the Become Player 
button below to fine-tune it.



Setting Up Your Instrument 
General advice about setting up your MIDI device
 When you are setting up a MIDI synthesizer or sound module to use it with FreeStyle, the goal is to be 
able to access as many sounds as possible in the device by name from within FreeStyle, and to get it to 
play as many different sounds as possible at the same time.

FreeStyle supports the devices listed in this section as best as it can. In order to do so, it assumes that 
the instrument is pretty much like it was when you first pulled it out of the box. This is especially true with 
regard to the automatic sound lists that appear for the device within FreeStyle. Most General MIDI 
devices work great with FreeStyle--even without any changes to the module itself by you. If you've made 
only a few changes to the instrument's settings, it should work fine, as long as you follow the 
recommendations mentioned in this on-line help for the device. If you've made substantial changes to the 
instrument (such as changing the internal banks of sounds), the sound lists probably won't work.

Here is a checklist of things you want to look into for a device if things don't seem to be working quite 
right:

> Make sure the device you are using is set up for multi-timbral operation with a sequencer. 
There is a wide variety of ways that devices handle this, so there is no set rule we can 
recommend here. Check the device's manual. (Many Korg and Yamaha devices call it 
"Multi" mode. Many Roland devices call it "Performance" mode.)

> FreeStyle attempts to use all channels that it thinks are available in the device. Some MIDI 
devices always receive on all 16 channels. Others can only receive on 8 channels at a time,
and you can often choose which channels you want to use. In addition, many instruments 
let you turn channels off if you want. In general, make sure FreeStyle knows which 
channels are available and which ones aren't. You do this in the Studio Setup command in 
the Setup menu. (If you get the Easy Setup window, you may need to click the "Launch 
Config program" button and then double-click on the icon of the device that appears.) 
Double-check the device to make sure its settings match what you tell FreeStyle.

> If your device is a controller, and you are also using it as a sound source for FreeStyle, 
make sure that its "Local Control" feature is turned off. Local control makes the keys on the 
keyboard trigger sounds in the on-board synthesizer. Since you will be doing this via 
FreeStyle, you want to turn it off in the synth itself. Otherwise, you'll trigger it from both the 
keyboard and FreeStyle and you'll get doubled notes.

> FreeStyle uses MIDI system exclusive, bank select, and program change events to call up 
sounds on MIDI devices. Be sure your device is set up so that it will respond to these types 
of messages. If it isn't, FreeStyle won't play the correct sounds.

> Some devices can handle drum kits on any receive channel. Others force you to use drums
on only a particular channel (usually channel 10). If so, FreeStyle needs to know which 
channel is reserved for drums. For the devices listed in this section, this has already been 
set up for you.



Edit Menu
General Preferences
General preferences are ones that affect the overall operation of FreeStyle.



Tips & troubleshooting (12 of 12)

Getting updates
Although we do not announce release dates and features of new versions of our software in advance, we 
will notify all registered users immediately by mail as soon as new releases become available. If you 
move from the address indicated on your registration card, please send us a note with your change of 
address so that we can keep you informed of future upgrades and releases.



Graphic Editing view (1 of 13)

Overview
FreeStyle provides two intuitive environments in which to view and edit your music: the graphic editing 
and notation views. These views are where you’ll do the majority of your work in FreeStyle. Both views 
exist in the same window, and you toggle between them using the buttons shown below. Think of them as
two windows through which you view the same music.

Both views can show any combination of players at any time. Just highlight the player names you want to 
see in the Ensemble palette. In the Graphic Editing view, each player is shown in a unique color or pattern
(depending on the setting in the Preferences command). In the notation view, each player gets its own 
staff or grand staff.

Both views can display any section or song in the document. Just choose the desired section or song 
from the pop-up menu at the top of the window. When you view a song, you see all of its sections 
together at once. The boundaries between sections are indicated by heavy vertical lines in the note grid.

Using the cursor buttons
Using the scrolling playback wiper
Working with    the pitch ruler to determine pitch
Changing a note's duration
Changing a note's pitch
Duplicating a note
Using cursor snapping for rhythmic precision
Selecting notes for editing
Inserting notes by hand
Zooming in to increase accuracy
Opening the note detail window for precise note info
Choosing a time signature (meter)



Guidelines for Choosing a Playback Device 
FreeStyle plays music best on a multi-timbral MIDI sound module or synthesizer that provides a good 
variety of instrument sounds. Multi-timbral means that the instrument can play more than one type of 
sound at a time (drums, bass, piano, etc.)

Why having a multi-timbral sound module or synthesizer is important
FreeStyle depends on your MIDI hardware to produce sounds. For example, when you record a piano 
part in FreeStyle, your MIDI sound module produces the piano sound that you hear. FreeStyle itself 
produces no sound whatsoever. Instead, FreeStyle precisely records performance information: when 
notes were played, what notes were played, how hard they were struck, how long they were held down, 
and so on. During playback, FreeStyle sends this performance information to the MIDI sound module, 
triggering the music that you hear. This is one of the reasons why MIDI sequencing is so powerful. It gives
you incredible flexibility in working with the performances you record and the instruments and sounds you 
choose to play them with.

FreeStyle supports General MIDI devices
FreeStyle works great with any MIDI compatible synthesizer. But many people find General MIDI devices 
particularly easy to set up and use. General MIDI is a term that refers to an industry-accepted standard 
setup for a multi-timbral MIDI device. MIDI devices vary widely in their architecture, sounds, and 
capabilities. General MIDI devices adhere to a simple set of characteristics that make them similar to all 
other General MIDI devices. For example, every General MIDI device provides a standard set of musical 
instrument sounds, including piano, bass, guitar, strings, various drum kits, and others. If a MIDI device 
supports General MIDI, you can be sure that it has this standard set of GM sounds. Many GM devices 
provide additional sounds as well. General MIDI includes other standard musical characteristics such as 
reverb, chorusing, and so on.



View Menu
Hide/Show Loop Markers
Hide Loop Markers makes the playback loop icons in the time line invisible. Show Loop Markers makes 
them visible.



View Menu
Hide/Show Rewind Marker
Makes the rewind marker visible or hidden in the time line of the graphic editing view. See Place Rewind 
Marker for more information about the rewind marker.



View Menu
Hide/Show Section Names
Hide Section Names makes section names in the time line invisible. Show Section Names makes them 
visible. This command will also hide and show section names in the notation view.



Setting Up Your Instrument
How to set up your MIDI instrument for FreeStyle
The topics below give you important setup information about using MIDI devices that are specifically 
supported by FreeStyle. To find your device, click the manufacturer of the device listed below.

General advice about setting up your MIDI device

Alesis
E-mu Systems
Ensoniq
Kawai
KORG
Kurzweil
Roland
Yamaha



Tips & troubleshooting (7 of 12)

If you hear "flanging" during playback
If you are using your MIDI controller as a sound source for FreeStyle, make sure that its "Local Control" 
feature is turned off. Local control makes the keys on the keyboard trigger sounds in the on-board 
synthseizer. Since you will be doing this via FreeStyle, you want to turn it off in the synth itself. Otherwise,
you'll trigger it from both the keyboard and FreeStyle, and you'll get doubled notes.



Setup Menu
Ignore mistakes
Causes the notation view to not display notes that are both very short and relatively quiet. Notes like 
these are often mistakes and cause the notation transcription to be inaccurate. To change the definition of
“short” and “quiet” choose “Edit Notation Settings”.



File Menu
Import into Section
FreeStyle lets you import Standard MIDI files into Sections in a Document. This is especially useful for 
transferring sequences from other sequencers into FreeStyle. Selecting Import into section displays a 
standard open file dialog.

FreeStyle then lets you match the tracks in the Standard MIDI File with the Players in your Document. 
Unlike opening a Standard MIDI File from scratch, when you import into an existing document you have 
the option of either assigning a track to an existing player, or of creating a player from a player template. 
The standard MIDI file will appear as a new section in the current document.

If you are having trouble importing complex sequences: Many sequencers let you work with “sections”, 
“chunks” or “sub-sequences”. The Standard MIDI File format has no provision for storing multiple sections
within a single file. The answer is to save multiple files, one for each section in your sequence. FreeStyle 
lets you import all of these SMFs at once using the “Import into section” feature.



Tips & troubleshooting (4 of 12)

Importing Standard MIDI files
FreeStyle only reads “Format 1” Standard MIDI files.

FreeStyle maps each track inside the SMF into a Player. Because of this do not use tracks that contain 
events for different channels. If you have tracks like this, pull them apart so that each track only has 
events for a single channel.

FreeStyle does not support program changes in the middle of a track. FreeStyle will use the first program 
change it sees in a track as the player’s sound, but will ignore subsequent program changes.

Since FreeStyle currently only supports one global tempo, it will use the first tempo event it sees as the 
global tempo, and ignore subsequent tempo changes. This also applies to time signature changes.



View Menu
In
Zooming in enlarges the note grid and notation display to make notes larger. Zooming in gives you a high 
degree of resolution and makes it easier to see the music. Use this command repeatedly to zoom in one 
magnification level at a time.



Page layout (5 of 10)

Indenting the first system
FreeStyle adds additional indentation for the first system on the first page of music. Use this setting to 
specify how far it will be indented.



Text Menu
Insert Page Number
A page number is a special text item that automatically displays the number of the current page. To insert 
a page number, click the Text tool to get the text cursor. Then create a new text box by clicking anywhere 
on the page, or edit an existing text box by clicking on it. Choose Insert Page Number from the Text 
menu. The page number appears at the location of the text cursor. The page number can be selected, 
cut, copied, pasted or formatted with any font and text setting (e.g. bold, italic, etc.) To make the page 
number appear on all pages, click it with the arrow cursor to select it and choose Pages/All Pages from 
the Text menu. To display it on all pages except the title page (page 1), choose Pages/Body Pages from 
the Text menu.



Text Menu
Insert Part Name
A part name is a special text item that shows the name of the player currently being displayed in the 
notation view. It automatically changes when you display a different player. If more than one player is 
showing, the word Score is used. To insert a part name, click the Text tool to get the text cursor. Then 
create a new text box by clicking anywhere on the page, or edit an existing text box by clicking on it. 
Choose Insert Part Name from the Text menu. The part name appears at the location of the text cursor. 
The part name can be selected, cut, copied, pasted and formatted with any font and text setting (e.g. 
bold, italic, etc.) The only thing you can’t do to a part name is edit the specific letters in the name. 
FreeStyle won’t even let you position the text cursor in the middle of a part name. To change the part 
name itself, change the name of the player in the Ensemble window. To make the part name appear in all 
parts, give it the All Pages text setting. To make it appear on the first page of all parts, give it the First 
pages text setting.

Remember, you must use the text tool to create a text box before you choose “Insert Page Number” or 
“Insert Part Name”. These commands INSERT text into an existing text box.



Graphic Editing view (10 of 13)

Inserting notes by hand
To insert notes by hand, drag from left to right with the brush cursor. Drag up and down to set the pitch. 
Use the cursor settings to control the duration and loudness of the notes you brush in.



Notation view (8 of 12)

Inserting notes by hand
Using the brush tool, press the mouse on the staff at the location you want (check the cursor location in 
the 'Status' bar at the top of the window), drag up and down to set the pitch, and drag left and right to set 
the duration. Use cursor snapping for easy rhythmic precision.    Double-click on the brush tool button to 
get a window where you can set the default duration and velocity (volume) of the notes that you enter with
the brush tool.    To set the default duration, pick the closest note value from the note popup menu and 
then fine-tune the duration with the staccato/legato slider.



Working with text (2 of 7)

Inserting text
To insert or edit text, begin by clicking the Text button to get the Text tool. Click or drag anywhere on the 
page to create a text box and type the desired text. If you click on existing text, you begin editing it. To 
insert a page number or instrument name that automatically updates, use the Text menu commands.



Installing A MIDI Driver 
A MIDI driver is software that you install into Windows (using the Drivers applet in the Windows Control 
Panel) that allows FreeStyle to communicate with the MIDI hardware device(s) it requires for playback 
and recording. A MIDI driver should have been included on a disk with your MIDI-equipped sound card, 
MIDI interface, or MIDI instrument (if it has a built-in MIDI interface). The driver needs to be Windows 
Multi-media Extensions (MME) compatible.

>> The MIDI driver must be installed before you try to run FreeStyle. FreeStyle won’t 
open if a MIDI driver has not yet been installed.

>> If you have a Mark of the Unicorn MIDI interface, such as the MIDI Express PC, 
MIDI Express PC Notebook, or MIDI Time Piece II PC, the FreeStyle setup 
program will ask you to update the driver currently in your system using Disk 1 of 
the FreeStyle setup disks. To do so, just follow the procedure below. This update is 
necessary for FreeStyle to work properly with your Mark of the Unicorn interface.

If you need to install a MIDI driver now as described below, you can get back into this Quick-Start guide 
afterwards by double-clicking the FreeStyle Help icon in the FreeStyle group in Program Manager.

How to install (or update) a MIDI driver in Windows 3.1
If possible, consult the installation guide for your MIDI device. In general, the process goes something like
this:

1. In Program Manager, open the Control Panel. (It’s usually located in the group called Main).

2. Double-click the Drivers applet to open it.

3. Click the Add button to add the new driver (or update one already in the system).

4. Choose “Unlisted or Updated Driver” from the list and click OK.

5. Insert the disk that has the driver on it (or use the browse button to go to the directory that has the new/updated 
driver) and then click OK.

6. When Windows locates the driver, a window appears with a list of one or more drivers. Select one and click OK.

7. Exit Windows and then re-open Windows to activate the new (or updated) driver.

How to install (or update) a MIDI driver in Windows 95
If you need to add a MIDI device to your computer, first turn off your computer and physically install or 
connect your MIDI device (multi-port interface, soundcard, etc.).    Be sure to check the device 
documentation for the proper physical installation procedure.    Once the device has been installed or 
attached, turn your computer back on.

If the new device is Plug & Play, Windows should either automatically load the device's driver files or 
prompt you to provide them (probably by inserting the floppy diskette included with the device).    Windows
95 should be able to load and configure the appropriate driver for the device automatically.    If this is the 
case, you can stop reading this file right now since the Windows 95 Plug & Play system will take care of 
everything automatically.

If the new device is NOT Plug & Play, you will have to load and configure the driver yourself.    To do so, 
open Control Panel and double-click "Add New Hardware" to start the "Add New Hardware Wizard".    In 
general, follow the Wizard's on-screen instructions.

IMPORTANT: When the Wizard asks...



>> "Do you want Windows to search for your new hardware?"

...select "No".    This will allow you to specify the MIDI device yourself. Selecting "Yes" to allow Windows to
search for non-Plug & Play MIDI devices MAY NOT WORK.    If you know what kind of device you want to 
add, you are better off selecting "No" and then manually specifying the device, as described below.

After selecting "No" and clicking "Next", the next step in the Wizard is to specify a hardware type.    From 
the Wizard's "Hardware types" list, scroll-down and choose...

>> "Sound, video and game controllers"

This type encompasses MIDI devices.    Click "Next" and then determine if your MIDI device appears in 
the Wizard's list.    If it does, select your device from the list, click "Next" and skip the following paragraph.

If the Wizard did NOT list your device, but you DO have diskette for the device,    insert the diskette into 
your floppy drive and click the special "Have disk..." button to the right.    In the resulting "Install From 
Disk" dialog, specify the floppy drive and then click "OK".    A list will appear containing one or more 
entries.    Choose the entry appropriate for your MIDI device and click "OK".

Continue to follow the Wizard's instructions.    When it finishes, a configuration dialog for your MIDI device
may appear.    At this point, you should consult your device's documentation for how to properly configure 
it using the dialog.

IMPORTANT: After the driver has been installed and configured, you will be prompted to restart Windows. 
You must restart Windows for the new driver to take effect.    When Windows restarts, your MIDI device 
should be ready to use.

>> NOTE: If the Wizard didn't list your MIDI device and you don't have a diskette for it, 
or for technical support on loading and configuring the device's driver, you should 
contact the device manufacturer, NOT Mark of the Unicorn, Inc. or Microsoft 
Corporation.



Instrument drop-down list
Choose your MIDI instrument from this drop-down list.



The Player Library (4 of 4)

Instrument Part Transposition
The part transposition settings affect how players created from this template will be notated when viewed 
on their own. It does not change the way the Players will sound. Enter the standard transposition for the 
instrument you are describing. For example, you would enter Bb for a Bb Clarinet. (The up/down pop-up 
menu has no affect if zero octaves is entered.) For Baritone Sax you would enter Eb and 1 octave up, 
since it is notated one octave and a major sixth above concert pitch.



Kawai    
GMega
Before you use FreeStyle with the GMega, you should set the serial interface mode.    For information on 
how to do this, see page 100 of the GMega manual. If you are using the GMega's built-in MIDI interface, 
set SER. I/F MODE = SEQ. If you connect the GMega to a separate MIDI interface, set SER.I/F MODE = 
OUT. FreeStyle automatically selects the General MIDI bank. 

K11
Before you use FreeStyle with the K11, you should set the serial interface mode. For information on how 
to do this, see page 94 of the K11 manual. If you are using the K11's built-in MIDI interface, set SER. I/F 
MODE = ON. If you connect the K11 to a separate MIDI interface, set SER.I/F MODE = OFF. You should 
also set Local Control = OFF. FreeStyle automatically selects the General MIDI bank.



Preferences (14 of 16)

Keep Destination Controllers
This preference determines what happens when you paste notes into a region of time where controller 
events currently exist, and the notes you are pasting have controller events along with them. The easiest 
way to understand this is through an example. Let’s say that you have copied a section of notes into the 
clipboard. FreeStyle has automatically included some volume controllers because they affect the notes 
you just copied. Now you go to paste the notes somewhere else, but there happens to be volume 
controllers at the location where you are pasting. When Keep Destination Controllers is unchecked, the 
volume controllers in the clipboard are pasted with the notes, and they replace the controllers at the paste
destination. When Keep Destination Controllers is checked, the volume controllers in the clipboard are not
pasted with the notes, and the controllers at the paste destination remain unaffected.



Record Menu
Keep Recording
Makes any music you have just recorded permanent in the sense that it will no longer be susceptible to 
the Undo Record command. Use this command if you are happy with what you have recorded so far and 
you want to keep it. After using the Keep Recording command, you can record more overdubs into the 
same take and freely use Undo Record without losing the “kept” material.



Tutorial: recording into a section (12 of 14)

Keep Recording & drum parts
The Keep Recording command in the Record menu is a way of protecting what you have recorded so far 
so the "Undo Recording" command in the Edit menu won't erase it.

This command is especially useful when recording drum parts. Most of the time, you’ll record each drum 
(e.g. kick, snare, hi hat) into a single take for a single player named Drums (or a similar name). But what 
should you do if you’ve recorded the kick and snare, and you like what you’ve got so far, but then you 
make a mistake when adding the hi hat? If you choose Undo Recording, you’ll lose the kick and snare 
also. If you choose New Take, the kick and snare will disappear.

This is where the Keep Recording command helps: it causes everything you’ve recorded into the take so 
far to be “kept” when you use Undo. So in our current example, if you recorded kick and snare, and you 
like what you have so far, you choose Keep Recording (from the Record menu) before you add anything 
else. Then, if you make a mistake when adding the hi hat, you can use Undo Recording to discard the hi 
hat without losing the kick and snare.    

> Note: Keep Recording is not a substitute for saving your file!    Keep Recording will 
protect your notes from Undo Recording, but new notes are never actually saved to
the file until you use Save or Save As in the File menu.



Tutorial: recording into a section (11 of 14)

Keep the music going
Once you have recorded your first pass and the record loop has begun repeating the section, you can 
continue the recording process without ever stopping the music. Here are the things you can do while the 
section repeats:

> Record a new take for the same player (remember, every take is preserved) by choosing 
New Take from the Record menu.

> Record-enable a different player and record takes for it. Click the record button to the left of 
the player name in the ensemble window.

> Discard everything you have recorded into a take (since the last time you used the "Keep 
Recording" command) by choosing Undo Record from the Edit menu.

> Do A/B listening tests between takes to decide which one you like best. Use the up and 
down arrow keys, type single digit take numbers, or choose takes with the take pop-up in 
the ensemble window.

> Record again into the same take to add more material to the take (see Keep Recording and
Drum Parts).



Keyboard shortcuts
In general these keyboard shortcuts can be used in combination with each other. For example, you can 
simultaneously hold down the Command Key to select a different tool, and the Shift Key to toggle the 
setting of Cursor Snaps to Grid.

Space Bar: Toggles Pause. (Begins playback if not paused)

ESC: Stop

` (~ without the shift key): Toggle Record

Enter key on the main keyboard: Rewind

Enter key on the numeric keypad: Rewind and begin playing

Delete: Same as choosing “Clear” from the edit menu

Up-Arrow: Previous Take

Down-Arrow: Next Take

Left-Arrow: Previous Player

Right-Arrow: Next Player

Numbers 1-9, and 0: Selects the current Player’s Takes 1-10

Shift: Toggles “Cursor snaps to grid” for dragging operations. (Stretch notes, move notes, paint notes, box select etc.). Extends 
selection for box-selection, or when selecting in lists.

Ctrl: Zooms to selection

Atl: Toggles selection/brush tool

Ctrl-Shift-Click: Zoom Back to last zoom level

Ctrl-drag notes: duplicates the selection

Alt-Scrub: Toggles “Silent scrubbing”



KORG    
01/W-series
FreeStyle automatically puts the 01/W into Sequencer Mode. In order for FreeStyle to do this, system 
exclusive data reception must be enabled. To do so, press the Global button and use the cursor and H 
buttons to scroll to the EXCL: field and then press the UP button until EXCL:ENA is displayed. For best 
results, leave the 01/W in Sequencer mode while working with FreeStyle.

i-series
FreeStyle automatically puts the i-series into Song Mode.    In order for FreeStyle to do this, system 
exclusive data reception must be enabled. To do so, press the Global button and use the cursor and H 
buttons to scroll to the EXCL: field and then press the UP or DOWN button until EXCL:ENA is displayed. 
For best results, leave the i-series in Song mode while working with FreeStyle. After FreeStyle puts the i-
series into Song mode or after you do so manually, you need to disable the sending of data from tracks in 
the song. To do so, use the Page buttons to find the Track Status page and set every track to EXT. The 
default is BOTH.

X-Series
FreeStyle automatically puts the X-Series into Sequencer Mode. In order for FreeStyle to do this, system 
exclusive data reception must be enabled. To do so, press the Global button and use the cursor buttons 
to scroll to page 3D FILTER2 and the EX: field.    Press the YES button so that EX:ENA is displayed. For 
best results, leave the X-Series in Sequencer mode while working with FreeStyle. You must also assign 
each track, in whatever Song is current when you switch to Sequencer mode, to a unique MIDI channel 
from 1-16. To do so after switching to Sequencer mode, press the Channel button and use the left cursor 
button to select the Track field. Go through each track from 1-16 and assign each a track a unique MIDI 
channel from 1-16.    The simplest setup would be to have Track 1=channel 1, Track 2= channel 2, Track 
3= channel 3, etc.

>> IMPORTANT NOTE: if you are using the built-in MIDI interface on your KORG X5 
(or other X-series synth) to connect it directly to the computer, see the important 
setup information at the end of this topic.

03R/W
Use 03R/W's front panel to manually enable system exclusive in the Global MIDI filter menu. After that, 
FreeStyle can automatically put the 03R/W into Multi mode. For best results with FreeStyle, you should 
leave the 03R/W in this mode.

05R/W
Use 05R/W's front panel to manually enable system exclusive in the Global MIDI filter menu (it should 
read "EX:ENA" on page 02C if you set it correctly). You only have to set this once because the 05R/W 
remembers the settings unless you change the battery or perform a Preset Data Load from page 05C. 
After that, FreeStyle can automatically put the 05R/W into Multi mode. For best results with FreeStyle, 
you should leave the 05R/W in this mode.

>> IMPORTANT NOTE: if you are using the built-in MIDI interface to connect your 
05R/W directly to the computer, see the important setup information at the end of 
this topic.

M1-series
For best results in FreeStyle, put the M1 into Combination mode with a Combination selected in which 
each part is set to one each of MIDI channels 1-8. Also, you should set the M1's global channel to be 16 
or some other MIDI channel than 1-8.



C-15/C-25
Put the C-15/C-25 into MIDI Multi mode and set the MIDI receive channel to 1. Turn Local Control OFF. 
Set Program Change ON. Only change sounds from FreeStyle, do not use the voice selector buttons on 
the front panel.

C-303/C-505
Set the MIDI receive channel to 1. Set Local Control OFF. Set Program Change ON. Only change sounds
from FreeStyle, do not use the voice selector buttons on the front panel.

Special Note for X5, X5D, X5DR, 05R/W, AG-10 and AG-3 Owners
If you have one of these KORG instruments and you DO use the special built-in "PC I/F" serial MIDI 
feature to connect it directly to your computer...

      YOU SHOULD install the latest driver for it.    The latest KORG PC I/F Windows MIDI 
driver (which works with all KORG devices that have the PC I/F feature) has been included 
on the first FreeStyle setup disk.    To install the driver, use the "Add New Hardware" icon 
(for Windows 95) or the "Driver" icon (for Windows 3.1) in Control Panel.

If you have a PC I/F-capable instrument, but you DO NOT use the special built-in "PC I/F" serial MIDI 
feature to connect it directly to you computer...

      YOU SHOULD NOT install the KORG PC I/F Windows MIDI driver.    If you would like to 
use the PC I/F feature, you will need a special connector cable.

In either case, please contact KORG or your KORG dealer for more information about the PC I/F feature.

Configuring    the KORG X5 When Using the Built-In Computer "Host" Interface 
Port 
The following settings must be made in the Global pages of the X5 when you are connecting the 
instrument directly to the PC via the built-in PC/IF computer "host" port.

Global Settings:

PAGE PARAMETER SETTING

00E PC/IF CLK 38.4 KBPS

02A MIDI GLOBAL CH Usually set to ch. #1

02B LOCAL OFF

02C EXT OUT SEL PCIF

02D PRG: ENA (to fully enable bank select messages)

AFT: ENA (to fully enable after touch messages)

02E CTRL: ENA (to enable MIDI controller messages)

EX: ENA (to enable system exclusive messages)

FreeStyle Setup:

It is important to install and configure the KORG driver prior to launching FreeStyle for the first time. Not 
doing so may result in failed MIDI communication between the X5 and the computer. If this has 
happened, delete the file called 'fmsprefs' from the FreeMIDI directory, (which is located in the Windows 
directory) and proceed with the driver installation/configuration below.



To install the KORG driver:

1. Open the Drivers control panel and click the Add button/Select Unlisted or Updated driver in the Installed Drivers 
window and click OK.

2. At the prompt, insert the FreeStyle disk 1 into drive A and click OK.

3. Select the KORG PC/IF (for X5 series, 05R/W, AG-10) driver and click OK.

>> NOTE: If an message appears indicating that the required driver is already installed
on the system, select NEWER.

4. When the driver has installed, a setup window will appear. Select the proper COM Port (usually COM Port 1) and click 
OK.

The MIDI Out Messages should all be checked by default. The Independent Synth/MIDI Out check 
box is for enabling MIDI input to the KORG instrument from an external MIDI device.

If the KORG instrument has been configured properly, you will be prompted to restart Windows. If the 
instrument has not been properly configured you will get the following error message:

>> No KORG instruments are found on the COM Port. Check your hardware 
configuration and select proper port.

Be sure that all GLOBAL settings and cable connections are correct, and repeat the steps above. Once 
the driver is properly configured, continue to the next section.

Launching FreeStyle for the first time:

After restarting Windows you are ready to launch FreeStyle. When you launch FreeStyle for the first time, 
you will be greeted by the following dialog box:

Welcome to FreeStyle! FreeStyle has detected a KORG instrument directly connected to this computer...

Click CONTINUE, and you will be prompted with the Studio Setup dialog screen. You should see a box-
like icon, named X5, appear in this window. For further details on configuring your studio, please refer to 
the installation chapter in the FreeStyle User's Manual.

NOTE: If the X5 icon appears as a keyboard, the setup has not been configured correctly. Remove the file
'fmsprefs' from the FreeMIDI directory and launch FreeStyle again.



Kurzweil    
K2000-series
For best results with FreeStyle, set the K2000's Drum Channel to 10. You can adjust this on the Master 
page. Also, set MIDI program change mode to EXTENDED. This is set on the MIDI Receive page. We 
have provided the default patch list for the Orchestral ROM expansion as Bank 9. If your K2000 does not 
have this upgrade, choosing patches from this list will cause the K2000 to display 'Not Found'.



Sections (4 of 6)

Letters of the alphabet are automatically assigned to 
sections
Each time you add a new section, it is automatically assigned a letter of the alphabet. This letter is 
displayed before its name in the Section list in the Arrangement window. When you type the Section’s 
letter, the section is added to the end of the current song if the Arrangement window is active.



Preferences (8 of 16)

Long Patch Names
Causes patch names to be displayed along with their source MIDI device as shown below.



Making your own metronome riff (1 of 1)

If the music you want to use for a metronome riff has been saved as a standard MIDI file (with one track 
only), just drop it into the "Metronom" directory on your hard disk. It then shows up in the Custom Riff pop-
up menu in the Metronome command in the Setup menu.

If not, just select the music in the Graphic Editing view or Notation view and then choose Save as 
Metronome in the Region menu. Be sure to only select one player's worth of music. Metronomes cannot 
consist of more than one player.



Setup Menu
Metronome
This command opens the Metronome window, which lets you adjust the metronome settings. FreeStyle’s 
metronome can play a speaker click on the computer’s internal speaker or a click that consists of any 
sound (such as a side stick or rim shot) produced by a MIDI drum machine or other MIDI instrument. It 
can also play a custom riff. A riff is a musical phrase played by a single player, usually a drummer. 
FreeStyle provides a wide selection of stock riffs; most are in the form of two-bar drum loops. You can 
create your own riffs by using the Save As Metronome command in the Region menu or by placing a 
standard MIDI file (.MID) in the FreeStyle’s metronom directory. (To delete a riff, just remove it from the 
directory.) Note that a riff doesn’t have to be a drum loop; it can be any single instrument that you want, 
such as a bass loop or a keyboard riff.

Sound during Playback/Recording
These two options control when FreeStyle plays the metronome. To turn off the metronome completely, 
uncheck both boxes.

Speaker Click
Produces a generic metronome click sound from the computer’s internal speaker. 

Custom Riff
If you want a custom riff, choose the desired riff from the menu, and then choose a drum kit or other 
appropriate sound.

MIDI Click
The MIDI click option produces a generic click using sounds from a MIDI instrument, such as a rim shot 
sound from a drum machine. The downbeat click occurs at the downbeat (beat 1) of each measure. 
Choose the desired pitch, velocity, and duration for the two click sounds.

Become Player
The Become Player button turns the currently selected custom riff into a player in the Ensemble window 
so that you can edit the riff and develop it further as part of each section or song. If the custom riff is not 
long enough to fill up a section, the player will be installed with a playback loop. This command is grayed 
out except when the custom riff option is selected.

Save As Default
Save As Default makes FreeStyle remember the metronome settings for new documents.

Audition
Hold down the Audition button to listen to the metronome using the current settings.



Synchronizing FreeStyle (6 of 8)

MIDI Beat Clocks
MIDI Beat Clocks consist of a continuous stream of real-time messages. They are produced by most MIDI
compatible drum machines and sequencers, and by some synthesizers (particularly those with built-in 
sequencers). MIDI beat clocks are transmitted 24 times per beat. If the master device changes tempo, the
MIDI beat clocks slow down or speed up accordingly; any slave device will follow this tempo change.



MIDI In
Indicate which MIDI input the device is connected to here.



MIDI Out
Indicate which MIDI output the device is connected to here.



MIDI Thru
If the MIDI device has another device connected to its MIDI Thru port, indicate so here.



Playback loops (7 of 9)

Modifying a playback loop
To change a playback loop, simply drag the loop markers in the graphic editing view’s time line. Dragging 
the loop source start marker will move both the source start and the source end marker, thereby 
preserving the length of the source material. Dragging the loop source end marker will shorten or extend 
the loop source area without affecting the loop source start point. Dragging the loop extent marker will 
change the number of repeats in the loop. If the loop extent marker is dragged so it lines up with the 
section end double-lines in the graphic editing view, then the loop will automatically resize when the 
section size changes (it will always loop until the end of the section). Loop Override markers cannot be 
dragged -- they can only be selected and deleted.

An alternate way to change the settings of a playback loop is to double-click on a loop marker. This will 
bring up the playback loop Detail dialog where you can easily set the loop start bar, end bar, and number 
of repeats.



Region Menu
Move
Changes the location of all currently selected material. You can either shift the music earlier or later in 
time from its current position, or you can specify an absolute time for the material to be moved to. The 
Move a copy option leaves the original material unmodified and makes an exact copy at the new location.



The Ensemble Palette (9 of 14)

Muting a player
Click the player's mute button to temporarily silence the player.



Tutorial: Recording into a section (2 of 14)

Name the Section
New documents open with a blank, four-bar section called Section A. Let’s rename it. Choose “Rename 
Section” from the Song menu and type in the name “Verse”.



File Menu
New
The New command opens a new FreeStyle document. You can create a new document at any time, even 
if another document is already open. The new document is given the temporary name “Untitled”. When 
you save the new document for the first time, you are given an opportunity to name it. You can have as 
many documents open at a time as you like.



Preferences (2 of 16)

New File at Startup
When this option is checked, FreeStyle automatically opens a new file when you first open the program. 
When it is unchecked, FreeStyle opens, but no file appears. Instead, you choose either New or Open 
from the File menu to open a file. This option also provides a pop-up menu from which you can choose a 
default ensemble for new files.



Song Menu
New Section
Creates a new, empty section, which appears in the Section list in the Arrangement window. In addition, 
the Graphic Editing view and Notation view display the new section.



Song Menu
New Song
Creates a new song in the FreeStyle document. A song consists of sections, and it can be displayed in all 
three FreeStyle views (Arrangement, Graphic editing, and Notation). When you create a new song, its 
name appears in the Song or View pop-up menu in each window as shown below. When you choose it, 
the song is displayed in the window. There is no limit to the number of songs you can create in a 
FreeStyle document.



Record Menu
New Take
A take is a place to store a performance by a single player in a specific section of music. You can record 
as many takes as you want for each player. Takes are numbered consecutively, and they can be instantly 
accessed from the take pop-up menu next to each player in the Ensemble window as shown below. You 
can also type single-digit numbers to select one of the first ten takes for a player, or use the up and down 
arrow keys to cycle through all the takes. The New Take command creates a new, empty take for the 
currently record-enabled player. It does the same thing as choosing New from the take pop-up menu in 
the Ensemble window (as shown below). Once you’ve created a new take, you are ready to record into it.



View Menu
Normal
Returns the display to the standard magnification level (the level you see when you first open a new 
document). In the Notation view, this command returns the display to 100% magnification.



Setup Menu
Notation
The notation settings affect how music is written in the notation editing view.



Region Menu
Notation based
This quantize option causes the notes to precisely match their rhythmic transcription in the notation 
display. Only the start locations are adjusted - not their durations. This type of quantization happens 
automatically according to FreeStyle’s music transcription technology, so no quantize options are 
provided. In short, what you see is what you get.



Quantizing (2 of 5)

Notation based quantizing
Notation based quantize uses the same process used to display your music in the Notation view. You can 
think of the Notation based quantize grid as being “flexible” in that it will bend and stretch to try to make 
musical sense of your selection. It can accommodate notes on even beat divisions as well as triplet 
divisions in one pass. In essence, what you see in the Notation view is exactly how the music will be 
quantized, except Notation based quantize does not change note durations.



Preferences (13 of 16)

Notation preferences
The Notation preferences are identical to the three commands in the Setup menu with the same name. 
The three notation preferences determine whether they are on or off when you open a new FreeStyle 
document.



Notation view (12 of 12)

Notation Preferences
The setup menu has several preferences for the notation display under the menu heading “Notation”. For 
more information, see The Notation Command (Setup Menu).



Notation view (1 of 12)

Overview
The notation view displays your music in standard music notation. You can view any section or song at 
any time by choosing it from the View pop-up menu at the top of the window. Each player is transcribed 
on a single staff or “grand staff”, depending on the instrument. Players can be shown or hidden at any 
time using the Ensemble window.

Dynamic transcription
What you see is what you get
Automatic instrument part transposition
Changing a note's pitch
Duplicating a note
Changing a note's duration
Inserting notes by hand
Using the scrolling wiper in notation
The shaded border in the notation view
Changing the magnification in the notation view
Notation Preferences



File Menu
Open
The Open command loads existing FreeStyle files and standard MIDI files from disk in the standard 
Windows fashion.



Quick-Start Guide (4 of 6)

Opening A FreeStyle Document
By now, you should have just clicked “Done” in the Studio Setup window (as shown in the previous help 
topic). FreeStyle will now open a new, untitled document. If it doesn’t for some reason, choose New from 
the File menu.



File Menu
Opening a standard MIDI file
FreeStyle only reads “Format 1” Standard MIDI files. 

When opening a standard MIDI file, you are given a chance to map each track in the file to any player 
template in your Player Library as shown below. Choose a player template for each track from the pop-up 
menu.

FreeStyle maps each track inside the SMF into a Player. Because of this, do not use tracks that contain 
events for different channels. If you have tracks like this, pull them apart so that each track only has 
events for a single channel.

FreeStyle does not support program changes in the middle of a track. FreeStyle will use the first program 
change it sees in a track as the player’s sound, but will ignore subsequent program changes.

Since FreeStyle currently only supports one global tempo, it will use the first tempo event it sees as the 
global tempo, and ignore subsequent tempo changes. This also applies to time signature changes.



Quick-Start Guide (3 of 6)

Opening FreeStyle For The First Time
Now you are ready to run FreeStyle for the first time! 

1. Make sure all of your MIDI gear is switched on.

2. In Program Manager, double-click the FreeStyle icon to launch the program.

After a brief moment, the FreeStyle start-up screen appears (displaying the FreeStyle logo), followed
by the Welcome to FreeStyle window shown below. If FreeStyle cannot find a MIDI driver in the 
system, it will notify you instead and exit back to Windows. If this happens, see Installing a MIDI 
Driver.

The Welcome to FreeStyle Window. Note: the directions in this window may be slightly different depending on your 
MIDI hardware.

3. After reading the “Welcome to FreeStyle” window, click OK to proceed to the Studio Setup window shown below, 
which lets you tell FreeStyle about your MIDI gear.

If you have a MIDI-equipped sound card in your computer, it should appear in this window, and no 
further settings should be necessary for the card. The same goes for KORG devices connected 
directly to the computer. If you have MIDI devices connected to a MIDI interface, you'll see a generic 
General MIDI device in the window as shown below. Replace the Generic device with your MIDI 
device by choosing it by name from the drop-down list.

4. When you are finished with the Studio Setup window, click “Done”.

If you don't see your MIDI device listed in the Studio Setup window drop-down list, see:What to do for 
MIDI devices that do not appear in FreeStyle’s list.

FreeStyle's Studio Setup window. To get information about an item in the window below, click it.





Opening standard MIDI files (1 of 1)

To open a standard MIDI file in FreeStyle, just choose Open from the File menu. Each track in the MIDI 
file will become a player in FreeStyle's Ensemble palette. A dialog appears asking you to map the tracks 
in the MIDI file to players in your FreeStyle player library. FreeStyle can only open Type 1 MIDI files.



Graphic Editing view (12 of 13)

Opening the note detail window for precise note info
Double-click a note to open the Note detail window.



View Menu
Out
Zooming out reduces the display to make notes smaller and to give you more of an overview of the music.
When you zoom out, you can see more at a time. Use this command repeatedly to zoom out one 
magnification level at a time.



Region Menu
Override Play Loop
This command operates on the measure that currently holds the playback wiper. It allows you to modify 
notes in the measure that are part of a playback loop without affecting other repititions of the the loop. For
example, you might want to create a drum fill in one measure of a drum loop without causing the fill to be 
in any other measures in the loop.



Page layout (1 of 10)

Page layout
FreeStyle gives you a considerable amount of control over the page layout in the notation view, while at 
the same time doing much of the work automatically for you.

Two separate page layouts: instrument parts and scores
The Page Layout dialog
Setting margins
Indenting the first system
Units of measurement
Changing the staff size
Changing the spacing between staves
Paper size and orientation
Saving text setups and page layouts using Stationery



File Menu
Page Layout
Controls the appearance of the pages in FreeStyle's music notation display. Settings in this window are 
saved on a per file basis. Units of measurement for the margins are inches (in), centimeters (cm), 
millimeters (mm), and points (pt). You can change the settings at any time.



Page layout (9 of 10)

Paper size and orientation
Your choice of paper sizes and orientations is determined by the printer you are using. These settings are 
available when you choose Print Setup from the File menu. Aside from the scaling, paper size, and 
orientation, the other settings in the Print Setup dialog are usually not needed when using FreeStyle. 



Copying and Pasting (3 of 6)

Paste
Paste places the contents of the clipboard into the current document. There are two ways to determine 
where the music gets pasted. By default, FreeStyle places the music in the same measure that the wiper 
is in and maintains the relationship the music originally had with the bar line. In other words, if the music 
you copied started on beat three of the measure it was in, then it will be placed at beat three of whatever 
measure the wiper is in. This is called “measure-relative” pasting, and it makes copying and pasting quick 
and easy. It lets you quickly duplicate chunks of music without needing to precisely position the wiper.

In some situations, you may prefer to have more control over the exact location where the music is 
placed. If you un-check “Paste measure relative” in the General section of the Preferences dialog, 
FreeStyle will paste relative to the current brush/cursor grid setting, rather than the bar line. For example, 
if you copied a note that began on beat three plus a sixteenth note, then pasted with a grid setting of one 
quarter note with the wiper near beat two, the note would be placed at beat two plus a sixteenth note, 
thus maintaining its original relationship to a quarter note grid.



Preferences (9 of 16)

Paste Measure Relative
Causes pasted material to be placed with the same relationship to the bar-line as when it was copied. If 
this option is not checked then material will be placed relative to the current brush/cursor grid setting. 



Edit Menu
Paste
When pasting music, pastes the contents of the Clipboard into the measure that currently holds the 
scrolling playback wiper (the measure currently playing back or where playback will begin). Material is 
placed in the measure in the same location from which it was cut or copied. (There is a preference to 
make the material paste at the exact wiper location instead.) To move the playback wiper, click the 
desired location in any ruler, or double-click the staff in the notation display in the desired measure.

When pasting text, the Paste command places the contents of the Clipboard at the current text insertion 
point. If there currently is no insertion point, text is pasted on the page at the same location from which it 
was copied (or cut).



Copying and Pasting (6 of 6)

Pasting into a song
When viewing a song in the editing window, you may be looking at several sections that are playing 
simultaneously. So if you paste into this view, which section gets your pasted notes? FreeStyle always 
picks the section in the top-most row in the arrangement window. Generally this will be row 1, the primary 
song structure row. If the music on the clipboard is longer than can fit into the section, FreeStyle will place
the extra music into the next section in the same row. Sometimes this is exactly what you want, but other 
times it will yield results you did not intend. In general it is less confusing and error prone to copy and 
paste while viewing a single section.



Copying and Pasting (5 of 6)

Pasting music into multiple players
If you copied music from multiple players onto the clipboard, FreeStyle will try to place the music back into
the players that it was originally copied from. If any of the players are no longer selected in the ensemble 
window, or if you are pasting into a different document that does not have players that match, you will be 
given the option of selecting destinations for the music as shown below. FreeStyle will temporarily 
remember the relationships you set up in this dialog, and try to use them the next time you paste. This 
lets you perform multiple copy/paste operations without needing to reset all the relationships each time.



Sections (6 of 6)

Pickup and overhang measures
Each section has a pickup measure and an overhang measure. This makes it possible to record notes 
into a section even if they occur before the downbeat of bar 1, or after what would normally be considered
the last bar of the section. The pickup and overhang measures are part of the section: they go with the 
section wherever the section goes. But the best part is that they don’t get in the way. For example, when 
you work with sections in a song, a four bar section is still a four bar section, even if it has a few pickup 
notes.



View Menu
Place Rewind Marker
The Rewind Marker is triangular icon that appears in the graphic editing view time line. You can place it 
anywhere you like. When it is visible, FreeStyle rewinds to it when you press the rewind button, instead of
rewinding to the beginning. This is convenient if you want to work on a particular section and do not want 
to have to rewind all the way to the beginning each time. Use the Show/Hide Rewind Marker command in 
the View menu to turn off (hide) and turn on (show) the rewind marker. Use the Place Rewind Marker 
command to choose where you want to put it. You can also just drag it in the time line with the mouse.



Playback loops (3 of 9)

Playback loop overrides
FreeStyle has an extra feature for playback loops called loop overrides. Loop overrides make it possible 
for you to make changes to measures within a playback loop without affecting the other repeating 
measures in the loop. For example, suppose you have a 1-bar drum pattern that is looping throughout 
your entire chorus. If you want to add a couple of fills here and there but leave the rest of the loop intact, 
you can just override the loop for the bars you want to change. In fact, if you just want to overdub your 
changes on top of the existing loop, FreeStyle will automatically make loop overrides for the measures 
that you record on top of.



Playback loops (1 of 9)

Playback loops
There are two kinds of loops that you can use in FreeStyle. A Record Loop causes time to cycle between 
two points. Whenever the end of a record loop is reached, the time wiper jumps back to the beginning of 
the loop and all players start playing whatever notes they have recorded at that time. A record loop is 
merely a convenience for recording notes repeatedly over the same section of time.

A playback loop, on the other hand, does not affect the passage of time at all. It affects the performance 
of a single take by a single player in a single section of music. When you create a playback loop for a 
take, you are asking FreeStyle to repeat one or more bars of the take for some number of times. For 
example, you could record one bar of a drum groove and create a playback loop which would cause that 
one bar to repeat four times, or until the end of the section. But while the drum notes are repeating, the 
time wiper will continue to move forward normally so other players can play normally. If the piano player 
does not have a playback loop, then when the wiper is in bar 4 the piano will be playing the notes that it 
has in bar 4, but the drummer will be playing the third repeat of the notes that it has in bar 1.



The Ensemble Palette (3 of 14)

Player info
Players in the Ensemble window represent much more than just a sound on your MIDI instrument. They 
also have many settings that control the way they are presented throughout the program. For example, 
the Player Info window has several options that control how the player is formatted when displayed in the 
Notation view.



Setup Menu
Player Library
A player is a single instrument in the Ensemble, such as piano or bass. The Player Library is a list of all 
the currently defined Player Templates available to FreeStyle. Player library entries are templates for use 
when adding new players to an ensemble. FreeStyle ships with a fairly long list of player templates 
already set up for you in the library. You can add your own templates, rename templates, and modify 
player characteristics, such as the default synth sound. The commands in the Player Library sub-menu let
you manage your player library.



The Ensemble Palette (2 of 14)

Players
Players in the Ensemble Palette act much like musicians: they play a certain instrument, and they can 
record multiple takes for each section of music. They only play one take at a time, but they remember 
every take you record, so you can play any take you want at any time. Just select it from the take pop-up 
menu. Each player has settings for volume, left/right panning, and more.



Preferences (1 of 16)

Overview
The Preferences command lets you set up FreeStyle in ways that best suit the way you work. The 
preferences are organized by categories, which appear as icons on the left side of the dialog box. Click a 
category icon to view its settings and make changes as desired. The options in each category are 
covered in the topics listed below.

New File at Startup
File save updates Player Library
Auto Scroll
Animate Piano
Audible Note Editing
Silent Scrubbing
Long Patch Names
Paste Measure Relative
Use Patterns/Colors to distinguish players
Use patterns to display velocities
Recording Preferences
Notation Preferences
Keep Destination Controllers
Auto-Select Controllers
Default controllers for pop-up

See Also:

Preferences Command (Edit menu)



Edit Menu
Preferences
The Preferences command lets you set up FreeStyle in ways that best suit the way you work. The 
preferences are organized by categories, which appear as icons on the left side of the dialog box. Click a 
category icon to view its settings and make changes as desired. The options in each category are 
covered in the following sections.



Song Menu
Previous/Next
This menu item has a hierarchical sub-menu with four sets of commands corresponding to the four 
important elements in a FreeStyle song: sections, players, takes, and sounds. In each case, the 
next/previous command moves to the next or previous item in the list. If you are at the end of the list, the 
Next command cycles you back to the beginning of the list; likewise, if you are already at the beginning of 
the list, the Previous command brings you to the end. This lets you cycle indefinitely with either command.

Next/Previous Section
If you are currently viewing a single section, these commands will cycle through all of the currently 
defined sections in the FreeStyle document. If you are currently viewing a song arrangement, they will 
cycle through only those sections which appear in the top row of the arrangement grid in the arrangement
window.

Next/Previous Player
Cycle through the list of players in the Ensemble window.

Next/Previous Take
Cycle through the list of takes for the currently record-enabled player in the Ensemble window.

Next/Previous Sound
Cycle through the list of sounds available to the currently record-enabled player in the Ensemble window. 
For General MIDI devices, you will hear a beep before cycling into drum sounds. That’s to warn you that 
you are about to change the drum sound on channel 10, which could cause your Riff Metronome to stop 
playing correctly if the Riff Metronome is using the same output device.



File Menu
Print
Prints the currently displayed players in standard music notation. Settings are provided for the number of 
copies to print, the page range, the paper source in the printer, and the destination (to the printer or to a 
file on disk).

Use the Help button in the print dialog box for more information on each option. Also refer to your printer’s
user’s guide.



File Menu
Print Setup
The Print Setup command defines the paper size, orientation, and special printer effects for the notation 
view in the document. Consult your printer’s user’s guide.



Device Properties
These settings tell FreeStyle various important things about the device, like whether it is a General MIDI 
compatible device, how it handles bank select messages (if at all), and so on.



Region Menu
Quantize
Changes the timing of the currently selected notes to make them rhythmically precise. Two types of 
quantization are provided: Notation based and Custom.



Quantizing (1 of 5)

Quantizing
Quantize lets you tighten up the rhythmic feel of your music by aligning the notes to a “Time Grid”. There 
are two main types of quantization available to you: Notation based and custom.

Notation based quantizing
Custom quantizing
Time offset
Swing



Quick-Start Guide (1 of 6)

Welcome to FreeStyle! This Quick-Start guide will help you get started as quickly as possible.

Check These Things First
Before you run FreeStyle for the first time, review the checklist below.

>> Have you installed a Windows MME-compatible MIDI driver in your computer’s system?

FreeStyle won’t run if a MIDI driver is not present. Even if you just want to explore FreeStyle and 
don’t intend to record or play back any music, you still need to install a MIDI driver. For more 
information, see Installing A MIDI Driver.

>> If you want FreeStyle to play music, do you have a MIDI playback device connected to (or 
installed in) the computer?

FreeStyle requires MIDI-equipped hardware to record and play back music. For playback, you can 
use a MIDI-equipped sound card or an external keyboard synthesizer or sound module. For more 
information, see Setting Up MIDI Playback

>> If you want to record your own music into FreeStyle, do you have a MIDI keyboard or other
controller connected to the computer?

For more information, see Connecting a MIDI Controller.

Once you’ve completed the checklist, use the browse button (>>) at the top of this help window to 
continue with this Quick-Start Guide.



The Ensemble Palette (13 of 14)

Rearranging and resizing the columns
Drag the column titles as shown. To change the width of the player and sound columns, drag the right 
edge of the column heading as shown.



Receive Channels
Indicate the MIDI channels on which the MIDI device receives MIDI data here. For example, if your MIDI 
device can receive data on channels 1 through 8, put a green dot in those channels. If your device can 
receive on all 16 channels, fill all sixteen with a green dot.



Tutorial: recording into a section (10 of 14)

Record a Take
You are now ready to record a Take. To see which player you will be recording into, look at the record 
buttons to the left of the player names in the ensemble window.    Get ready to play and then click the 
rewind, record and play buttons in the Control Palette.    If Wait For Note is checked, FreeStyle will 
endlessly cycle the first bar until you play your first note.    If you don't want it to do so, uncheck the Wait 
For Note command in the Record menu.

Play music for as long as you like into the section.    Notice the following things happen as you record:

> If you play past the end of the section, the section boundary moves as needed to 
automatically adjust the length of the section.

> Notes appear on the screen in the notation or graphic editing view immediately as you play 
them.

> If you have the Auto Loop Record feature turned on, FreeStyle automatically sets up the 
record loop over the region of music you just played -- after you stop playing for 2 bars.



Tutorial: recording into a song (2 of 4)

Record into the song
In FreeStyle you can also record directly into a song arrangement. There are two different ways you can 
do this:

> Single section recording within the context of a song

> “Follow Song” recording into multiple sections

First make sure that the graphic editing/notation window is displaying the song “My Song.” To do this, click
on the “View:” popup menu in the upper left corner of the window and choose “My Song.” Section names 
are listed first in this popup, followed by a divider line, then all of the song names.

Another way to show your song in the graphic editing/notation window is to click on the arrangement 
window, or choose “Arrangement Window” from the Windows menu.



Tutorial: recording into a section (3 of 14)

Record Loop
The Record Loop consists of a small pair of draggable repeat sign markers in the time line as shown 
below. These markers cause playback to endlessly repeat a range of measures within a section. The area
being cycled can be as short as one bar or as long as the entire section. When the record loop markers 
are visible, the record loop is on. To toggle it on and off, use the Toggle Record Loop command in the 
Record menu. For this tutorial, toggle them off because we will be using the Auto Loop Record feature.



Record Menu
The Record menu contains all of the commands and options that are involved during the process of 
recording music into FreeStyle. Note that all of these commands can be mapped to a remote control key 
on your MIDI keyboard (or other controller), which frees you up completely from the computer while 
recording. For more information, see Remote Controls.

Keep Recording
New Take
Delete Take
Erase Take
Wait for Note
Auto Loop Record
Smooth Record Loop
Follow Song
Set Record Loop
Toggle Record Loop
Advance Record Loop



Tutorial: recording into a section (4 of 14)

Record menu options
The Record menu has several handy features you can use while recording. Most of the time, you’ll want 
to set them up before you begin recording. In each case shown below, check the menu item to turn on the
feature. Uncheck it to turn it off.    For this tutorial, check Wait For Note, Auto Loop Record, and Smooth 
Record Loop.



Songs (8 of 9)

Record-enabling a section in the Arrangement grid
Click it to record enable a section. The record-enabled section gets a red bar on it.



Sections (5 of 6)

Recording into a section
Recorded notes and controller data always go into the currently record-enabled section (as well as the 
current take for the record-enabled player). To record-enable a section, either choose it from the pop-up 
menu in the Ensemble window, or click any instance of it in the layout grid of the Arrangement window. A 
red bar appears on the currently record-enabled section in the Arrangement grid.

When using sections in FreeStyle, you can think in terms of “patterns” (like verse, chorus, bridge, etc.), 
but you don’t have to. You can also use sections in a linear fashion. FreeStyle even lets you go back and 
forth between thinking linearly and thinking in terms of patterns.

        



Tutorial: recording into a section (14 of 14)

Recording into another new section
Now you are ready to record another section. Choose “New Section” from the song menu and type in the 
name “Chorus” for the new section. FreeStyle will present you with a new blank section for recording. 
Note that the “View:” popup menu in the graphic editing / notation window now shows the name “Chorus.”
Record some music for one or more players into this new section as described above. Then read 
Recording into a song.



Preferences (12 of 16)

Recording Preferences
The four recording preferences are identical to the four commands in the Record menu with the same 
name. The four record preferences determine their settings when you open a new FreeStyle document.

            



Edit Menu
Redo
Restores the last action that was reversed with Undo.



Region Menu
The Region menu contains commands that act on the currently selected notes. So be sure to select the 
notes you want to affect before choosing a command from the Region menu.

Quantize
Transpose
Move
Save as Metronome
Create Play Loop
Override Play Loop



Setup Menu
Remote Controls
The Remote Controls feature lets you assign commands in FreeStyle to the keys on your MIDI keyboard. 
Just drag an icon onto the piano keyboard for each command that you want to control with a MIDI key. 
After you leave the dialog you will be able to hold down the trigger key (or keys) and then press that MIDI 
key to perform the command assigned to it. To remove a command from a key, drag it to the trash.

FreeStyle makes it easy for you to use Remote Controls and at the same time avoid triggering commands
unintentionally. Commands only trigger when you hold down the trigger key clump. A key clump is a set of
keys that activate the Remote Controls when they are held down together. The Remote Controls are only 
active while the key clump is being held down. This makes it next to impossible to accidentally enable the 
Remotes. Best of all, you can choose any combination of keys you want. FreeStyle’s factory default key 
clump is C1Db1D1. You can, however, choose any combination of keys you want––anything that you are 
sure you will never play––by dragging the trigger key onto the desired keyboard keys. If you don’t want to 
use the key clump technique, you can use a MIDI controller instead.

Remote Controls
Turns Remote Controls on and off completely. When they are turned off, none of the remotes will trigger 
FreeStyle.

Command Trigger
Lets you choose how you want to activate the Remote Controls.

Controller
This option lets you choose a MIDI controller event to activate all of the remotes.

Key Clump
A key clump is a set of keys that activate the Remote Controls when they are held down together. The 



Remote Controls are only active while the key clump is being held down. 

Command Trigger Source
Lets you specify the MIDI device in your MIDI setup that you will be using for Remote Controls. FreeStyle 
can pay attention to input from any device or from a single device that you specify. If the device you want 
to use does not appear in the menu, use the Studio Setup command in the Setup menu to add the device.

Print
Prints a diagram of the remote controls for your convenience.



Song Menu
Rename Section
After choosing a section, you can use this command to change its name.



Song Menu
Rename Song
Lets you change the name of the song that is currently displayed. If the window is currently showing a 
section instead of a song, the Rename Song command grays out to indicate that it is not available. To 
make it available, select a song from the pop-up menu.



The Ensemble Palette (14 of 14)

Resizing the Ensemble palette to conserve screen space
You don't always want to have the Ensemble palette all the way open, so you can conserve screen space 
by using the resize button on the right-hand side of its title bar. Doing so toggles it between two sizes: one
is a small size that you set manually with the resize box (in the lower righthand corner). The other is 
opened up all the way.



File Menu
Revert to Saved
The Revert to Saved command closes the document without saving changes and reopens the last saved 
version of it from disk. This command does the same thing as choosing Close, answering “No” to save 
changes, and then re-opening the same file. Revert to Saved is useful for discarding all changes you 
have made to a document since you last saved it.



Roland    
D-10/110
No specific preparations are necessary to use these devices with FreeStyle.

JD-990
FreeStyle automatically puts the JD-990 into Performance mode. For best results, leave the JD-990 in 
Performance mode with a Performance selected in which parts 1-7 are assigned to channels 1-7 and 
rhythm part 8 is assigned to channel 10.    Preset Performance B-09 'Pop Kit' is an example of this type of 
Performance.

JV-30
Some of the patch lists for the JV-30 appear to contain patches with duplicate names. Although these 
patches have the same name, they are not identical. Patches with a # symbol after their number are from 
the MT-32 set. Patches with a + symbol after their number are from the Variations set. All other patches 
are from the standard set. For best results with FreeStyle, if you are using the JV-30 as your controller 
keyboard, turn local control OFF on the Master MIDI function page.

JV-35
For best results with FreeStyle, if you are using the JV-35 as your controller keyboard, turn local control 
OFF on the Master MIDI function page.

JV-50
For best results with FreeStyle, if you are using the JV-50 as your controller keyboard, turn local control 
OFF on the Master MIDI function page.

JV-80
FreeStyle automatically puts the JV-80 into Performance mode. For best results, leave the JV-80 in 
Performance mode with a Performance selected in which parts 1-7 are assigned to channels 1-7 and 
rhythm part 8    is assigned to channel 10. Preset Performance A-01 'Jazz Combo' is an example of this 
type of Performance. For best results with FreeStyle, if you are using the JV-80 as your controller 
keyboard, turn local control OFF.

JV-880
FreeStyle automatically puts the JV-880 into Performance mode. For best results, leave the JV-880 in 
Performance mode with a Performance selected in which parts 1-7 are assigned to channels 1-7 and 
rhythm part 8    is assigned to channel 10. Preset Performance A-01 'Jazz Combo' is an example of this 
type of Performance.

JV-90
FreeStyle automatically puts the JV-90 into Performance mode. For best results, leave the JV-90 in 
Performance mode with a Performance selected in which parts 1-7 are assigned to channels 1-7 and 
rhythm part 8    is assigned to channel 10. Preset Performance A-01 'Jazz Split' is an example of this type 
of Performance. For best results with FreeStyle, if you are using the JV-90 as your controller keyboard, 
turn local control off.

SC-50
No specific preparations are necessary to use this device with FreeStyle.

SC-55/SC-55mkII
Some of the patch lists for the SC-55 appear to contain patches with duplicate names. Although these 



patches have the same name, they are not identical. Patches with a # symbol after their number are from 
the MT-32 set. Patches with a + symbol after their number are from the Variations set. All other patches 
are from the standard set.

XP-10
There are two ways to connect the XP-10 to your computer: either using MIDI cables with a MIDI interface
(such as the PC-MIDI Flyer, etc.) or directly connecting to the PC serial (COM) ports, using a special 
cable (purchased separately from Roland). It is important to install and configure the appropriate MIDI 
driver prior to launching FreeStyle for the first time. If you are using an interface, install the driver 
according to the manufacturer's instructions, and then read the section below, labeled "If You Use a MIDI 
Interface". If you are using the ROLAND serial driver, simply follow the steps outlined in the section 
labeled "If You Use a Serial Cable".

If you have attempted to run FreeStyle before installing the appropriate driver, FreeStyle may cause an 
erroneous studio setup document to be created, which will result in no MIDI communication between the 
XP-10 and the computer. If this has happened, delete the file called 'fmsprefs' from the FreeMIDI 
directory, (which is located in the Windows directory) and continue with the driver 
installation/configuration.

If You Use a MIDI Interface:

If you use MIDI cables, you will need two MIDI cables and a MIDI interface . (Please refer to the section 
labeled "Connections Using MIDI Cables" in Chapter 8 of the XP-10 manual for details on how to make 
the proper connections.) Set the computer switch on the rear panel of the XP-10 to "MIDI".    Turn "Local 
Control" Off on the XP-10. (Please refer to the section labelled "Turn off the XP-10's Local Control" in 
chapter 7 of the XP-10 manual for details.) After the initial WELCOME! message the program will present 
you with the Studio Setup window, where you tell FreeStyle what MIDI gear you have.    Click on the drop-
down list of devices and select XP-10 from the list of supported devices. NOTE: The default device is set 
to "Generic GM".    Click the Expand button to tell FreeStyle about the device's MIDI connections. If you 
have no other MIDI gear, click DONE. Otherwise, click the ADD button to add another device, and 
configure it appropriately.    That's all there is to it!

If You Use a Serial Cable:

If you use a serial cable, connections can be made directly to the COM port on the back of the PC. 
(Please refer to the section labeled "Connections Using a Computer Cable" in Chapter 8 of the XP-10 
manual for details on how to make the proper connections.) Install the driver by referring to the section 
below that applies to you.

Windows 3.1 Installation of the ROLAND Serial MIDI Driver:

Set the computer switch on the rear panel of the XP-10 to "PC-2" prior to powering on the unit. Turn 
"Local Control" Off on the XP-10. (Please refer to the section labelled "Turn off the XP-10's Local Control" 
in chapter 7 of the XP-10 manual for details.) Open the Drivers control panel and click the Add button.    
Select Unlisted or Updated driver in the Installed Drivers window and click OK. Insert the FreeStyle disk 1 
into your computer, select the appropriate drive to scan, and click OK. Select the Roland Serial MIDI (for 
XP-10, SC series, etc.) driver and click OK. Check that you have the correct COM port setting and 
RESTART WINDOWS.

Windows 95 Installation of the ROLAND Serial MIDI Driver:

Set the computer switch on the rear panel of the XP-10 to "PC-2" prior to powering on the unit. Open 
Control Panel, double-click the Add New Hardware icon and click Next. When the Add New Hardware 



Wizard asks if you want it to scan for new hardware, click No. Clicking Yes won't work -- the Wizard does 
not know how to automatically recognize the ROLAND Serial MIDI driver. Select Sound, video and game 
controllers and click Next.When the Wizard asks for the manufacturer and model of your new hardware, 
click the special Have Disk... button.    Insert the FreeStyle disk 1 into your computer, select the 
appropriate drive to scan, and click OK. After the Wizard scans the disk, it should present youwith a single
choice for Roland Serial MIDI hardware. Click OK and then click Finish to have the Wizard install the 
driver software onto your computer. Finally, the Wizard should inform you that Windows must be 
restarted. When you launch FreeStyle for the first time, it should automatically detect a ROLAND device 
connected to the COM port, and assign the correct properties. If the PatchList for your device is not 
correct, simply select the correct patch list for your device from the drop-down menu.



File Menu
Save
When you first create a new FreeStyle document or open an existing one from disk, the document is 
stored into the computer’s temporary Random Access Memory (RAM) as you work. Changes you make to
the document occur in the temporary version in RAM. The Save command writes the current state of your
document to disk to store it permanently, even after you quit FreeStyle and switch off the computer. If you 
quit FreeStyle without saving, or if the computer is suddenly interrupted before you have a chance to save
the document, all changes you have made to it since you last saved are lost forever. It is therefore 
important to save very often to avoid losing your work.

If you have previously saved a document, the current state replaces last saved version. If you are saving 
a document for the first time, a dialog box appears to ask you to name it. This dialog box is identical to the
Save As dialog box explained in the next topic.

Save frequently––every time you make a change that you like. Doing so prevents you from losing work 
should FreeStyle or the computer be interrupted.



Setup Menu
Save “Player”
Takes the settings for the currently selected player in the Ensemble window (or just the record-enabled 
player if several players are selected) and saves them in the player library. If a template with the same 
name already exists in the library, FreeStyle asks you if you want to replace it.



File Menu
Save a Copy As
Save a Copy As does the same thing as Save As (see Save As) with the following difference: after using 
Save As, the newly created document stays on the screen. After using Save a Copy As, the original 
document remains on the screen.



File Menu
Save As
The Save As command is what you use the very first time you save a new document. Save As lets you 
name the document and choose where you want to store it on your hard disk. Save As also lets you save 
the currently open document on disk under a different name, preserving the last-saved version of the 
original document. Save As is useful when you would like to make changes to a document and save 
them, but you still want to preserve the original document. In this case, the Save command would not be 
the right command to use because it would replace the original document with the newly modified 
document, thus erasing the original document. Instead, Save As creates a new document on disk with the
changes in it, and the original document remains unmodified under its original name.

Save As file formats
The Save As command lets you save a file in several different formats:

FreeStyle
FreeStyle is the standard FreeStyle file format. Use this format to save your FreeStyle files.

Stationery
When the Stationery option is selected, the file is saved as a Stationery file, which acts much like a 
stationery “pad”. When you use a stationery pad, you “tear off” a blank sheet of paper to work with and 
leave behind the original pad. Stationery documents on the computer work much the same way. 
Stationery files can be opened, but the computer will prevent you from modifying the original stationery 
pad file by making you Save As when you attempt to save the file. This option is great for preserving files 
that you do not want to modify and that you use regularly as a “template” from which to build new files. 
When saving as Stationery, everything in the file gets saved except notes and controllers. Saved items 
include players, sections, and songs.

S.S. (Song Structure) Stationery
This option is identical to the Stationery option (see the previous paragraph) with the following exception. 
Only songs and sections are preserved in the file; players are not. When you first open a new file using a 
Song Structure Stationery file, FreeStyle asks you to choose an ensemble. This is a convenient way to 
create song structures that you frequently use, such as a pop song structure with Intro, Chorus, Verse, 
Bridge, etc. and choose any type of ensemble you want to fill the sections. This feature combines 
convenience with flexibility: you have quick access to a customized song structure and you get to choose 
any ensemble to work with.

Standard MIDI File
This option saves the section or song currently displayed in the Graphic Editing window (shown in the 
View pop-up menu) as a standard MIDI file on disk. Music saved in this file format can be opened with 
any music program that also reads and writes Standard MIDI Files––even programs that run on other 
types of computers. Each player is saved as a track, and only the current take for each player is included;
other takes are not.

Be sure to choose the desired section or song in the View pop-up menu in the Graphic Editing window as 
shown below before you choose Save As from the File menu. Also be sure that the current takes for each 
player are the ones you want to include. Basically, what you hear when you play is what will be included 
in the Standard MIDI File.

When saving as a Standard MIDI File, only the song or section displayed here is included in the file, so be
sure to select the desired item before saving.





Region Menu
Save as Metronome
Makes the currently selected material into a metronome riff, which appears in the Riffs pop-up menu in 
the Metronome command dialog box in the Setup menu. You then have quick access to it as a 
metronome for any future recording and playing. The riff can be of any length, and it doesn’t even have to 
be drums. You can make riffs out of just about anything, such as a bass line or keyboard lick. The only 
restriction is that the riff can only use one sound. If you have music belonging to more than one player 
selected, it will be merged together into a single riff.



Window Menu
Save Window Layout
Remembers the current positions of all the windows on the screen and uses them when opening a new 
document.



Page layout (10 of 10)

Saving text setups and page layouts
Once you have chosen page sizes, margins and formatting options, entered and styled page numbers, 
part names, your song title, composer name, and copyright notices, you may not want to do it all again for
your next song. Use the Save As command to save the file under a different, generic name (such as 
"Lead Sheet Template"), and then delete all of the takes in the file. Then, whenever you want to start a 
new lead sheet, open the empty template file and use the Save As command to save a copy of it under a 
different name (such as the name of the song you are going to record).



Sections (1 of 6)

Overview
Sections are the basic building blocks of music in FreeStyle. A section is a place to store music. It can be 
anything, from a 2-bar drum loop to a 300-bar orchestral movement. It consists of a “pickup” measure, a 
start, an end, and an “overhang” measure. Most importantly, each section has its own set of takes for 
each player. For example, take 1 for the Piano player in the Intro section is different from the Piano 
player’s take 1 in the Verse. Only one take is active for each player at any time in a section. But different 
players can play different takes. For example, the piano player might be playing take 3 in the Verse, while 
the bass player is playing take 6.

Creating a section
Changing the length of a section
Letters of the alphabet are automatically assigned to sections
Recording into a section
Pickup and overhang measures



Edit Menu
Select All
Selects all displayed material in the front-most window. If a part is hidden, it is not selected. In the notation
window, notes from all parts currently showing are selected on all pages.



Songs (7 of 9)

Selecting a section in the Arrangement grid
Click a section to select it. The selected section gets a “shimmering” dashed border around it. It also gets 
a red bar on it, indicating that it is now record-enabled. Once selected, you can do things like snip it with 
the scissors button, glue it with the glue button, delete it, etc.



Controllers (4 of 7)

Selecting controllers for editing
To select controllers for editing, use the I-beam tool and then drag over them. If several Players’ 
controllers overlap in a section, show only the Players whose controllers you want to edit and hide the 
others.



Graphic Editing view (9 of 13)

Selecting notes for editing
To select a group of notes, drag over them. Or shift-click each one.



Working with text (3 of 7)

Selecting text
To select individual words or letters, click and drag over them with the Text Tool. To select or move the 
whole text box, use the Arrow Tool.

      



Tips & troubleshooting (8 of 12)

Send in that registration card!
We are happy to provide technical support to our registered users. If you haven’t already done so, please 
take a moment to complete the registration card in the front of the manual and send it in to us. When we 
receive your card, you’ll be placed on our mailing list and database, making you eligible for free, unlimited
technical support.



Tips & troubleshooting (11 of 12)

Sending in suggestions
Our technical support telephone line is dedicated to helping registered users solve their problems quickly. 
In the past, many people have also taken the time to write to us with their comments, criticism and 
suggestions for improved versions of our software. We thank them; many of those ideas have been 
addressed in this version of FreeStyle. If you have features or ideas you would like to see implemented in 
our music software, we’d like to hear from you. Please write to the FreeStyle Development Team, Mark of 
the Unicorn Inc., 1280 Massachusetts Avenue, Cambridge, MA 02138.



Record Menu
Set Record Loop
The Record Loop repeats any span of time that you specify. The Record Loop affects whatever is 
currently playing (either a section or a song).

Shortcut for setting the Record Loop
Use Ctrl-L to make record loop markers appear in the time line and then drag them anywhere you want. 
Record loops are always on measure boundaries, however, so the markers will snap to the nearest 
barline.



Tutorial: recording into a section (9 of 14)

Set the tempo and metronome
It is important to play along with FreeStyle's metronome when you record.    Otherwise, FreeStyle's beats 
and barlines won't match up with what you play.    So before you record, drag the tempo slider in the 
Control palette to the desired tempo.    You can raise or lower the tempo afterwards without affecting the 
pitch of the music.    This is a great technique for playing in music accurately: record it slow and then play 
it back at normal speed.    To set up a metronome, choose Metronome from the Setup menu.



Page layout (4 of 10)

Setting margins
The margin settings control the boundaries of staff systems on the page. There are separate margin 
settings for the first page, left (even numbered) pages, and right (odd numbered) pages. Set them in the 
Page Layout command in the File menu.



Setting Up MIDI Playback    
FreeStyle requires MIDI-equipped hardware to record and play back music. For playback, you can use 
one of the following:

A MIDI-equipped sound card
MIDI-equipped sound cards ship with a MIDI driver, which you have probably already installed. If so, 
FreeStyle should automatically recognize the driver and card when you first run FreeStyle. If you know for
sure that the card’s MIDI driver hasn’t been installed yet, do so now. See Installing a MIDI Driver for more 
information.

An external keyboard synthesizer or sound module
If you have MIDI keyboard synthesizer or sound module for playback, there are several ways it could be 
connected to the computer, depending on your hardware. Below are several of the most common ways:

Figure 1:    Several common ways to connect a MIDI playback device.

For more information about playback devices, see:

Guidelines for choosing a playback device



Setting Up Players for a Non-General MIDI Device

In FreeStyle, you work with players in an ensemble; each player represents a different instrument, such 
as guitar, bass, drums, piano, and so on. Each player must be assigned to an instrument sound in your 
MIDI playback device before you can begin using FreeStyle. Otherwise, the player may not play the 
correct sound.

If the device you are using for playback is not a General MIDI device, you need to choose a sound for 
each FreeStyle player manually. Since you are just starting out with FreeStyle, the best way to do this is 
to edit the Player Templates in the Player Library so that FreeStyle will remember the sound you have 
chosen any time you create a new file.

To choose sounds for the player templates in the Player Library:

1. Close the currently open FreeStyle document by choosing Close from the File menu.

If you have modified the file in any way, it will ask you if you would like to save changes. At this point,
you probably haven’t done anything that you want to keep yet, so click No.

2. Go to the Setup menu, and choose Edit Player Library under the Player Library entry.

The Player library window appears.

3. Choose each player template one at a time from the drop-down list at the top of the window, and for each one choose
an appropriate sound from the Sound drop-down list below the player name.

At this point, what you see in the sound drop-down list depends on whether or not FreeStyle is 
familiar with your MIDI instrument. If it is, then the sound drop-down list displays the device’s factory 
default sounds, and you can continue to assign sounds to your players. If not, see What to do if you 
see a generic sound list or What to do if you see MIDI channels instead of a sound list.

4. When you have finished assigning the desired sound to each player, click OK.

5. Proceed to Auditioning players.



Setup Menu
The setup menu provides ways to manage your music-making environment in FreeStyle.

Studio Setup
Player Library
Ensemble Library
Add Player
Delete Player
Edit Player Info
Notation
Toggle Metronome
Metronome
Remote Controls
Sync
Turn All Notes Off



Setup Menu
Show Entire Pickup Bar
When this command is checked, FreeStyle shows the entire pickup bar (measure zero) in the currently 
displayed section or song––even if the pickup bar is empty. Below are some examples.



The Ensemble Palette (10 of 14)

Showing and hiding a player
Click the show button to show or hide a player. To show the player by itself (hiding all other players at the 
same time), click the player’s name.



Showing and hiding players (1 of 1)

As you work with either the Notation or Graphic Editing views, you’ll constantly be changing what players 
you are viewing at any given time. For example, you may want to view a single player by itself, without the
clutter of other instruments getting in the way.

Use the Ensemble window to control whether players are visible or hidden using the techniques below:

> To view a single player alone (and hide all other players): click the player’s name.

> To turn a single player on or off without changing the others: shift-click the player’s name or 
click the colored tab in the “Show” column next to its name (or its record button).

> To view a certain set of players: click the name of the first player and then shift-click the 
others.

> To view all players: shift-click the name of all players that are currently hidden.

When changing the status of more than one player (making three more players visible for example), it is 
faster to do so in the Graphic Editing view than the Notation view. Try switching to Graphic Editing first 
and switch back to notation when you are done.



Preferences (7 of 16)

Silent Scrubbing
Causes notes to not play when you grab the wiper and drag it left and right to scrub the music. When this 
option is unchecked, all unmuted players play when you drag the wiper. Silent scrubbing is useful when 
doing a lot of cutting and pasting, which requires constant wiper placement.



Tutorial: recording into a song (3 of 4)

Single-section recording within a song
In the arrangement window, click on one of the “Verse” sections that you placed on the arrangement grid. 
A red bar will appear across the top of the section to indicate that the section is record-enabled. 
Recording can now happen only within the bounds of the “Verse” -- notes that you play while the wiper is 
over any other section will not be recorded. However, each section in FreeStyle has a pickup bar and an 
overhang bar that overlap neighboring sections in the arrangement. Therefore, notes can actually be 
recorded 1 bar before what you think of as the start of the “Verse”, and up to 1 bar following what you 
think of as the end of the “Verse.” Notes recorded in the pickup or overhang measures of a section 
nonetheless are part of that section, not part of neighboring sections in the arrangement. To see this in 
action, let’s record something new. Choose “New Take” from the Record menu. Look in the Record menu 
and make sure that “Follow Song” is not checked. Next, make sure that the record button is on in the 
control palette, then click on the rewind and play buttons. Start playing something a beat or so before the 
wiper gets to bar 1, and continue playing past the end of the first “Verse.” You will notice that notes appear
in the graphic editing view as you play until one bar past the end of the record-enabled section. Then the 
rest of your notes are ignored until the time wiper reaches the next instance of “Verse” in your 
arrangement. Now choose "Verse" from the "View:" popup menu in the upper left corner of the graphic 
editing view.    You will clearly see that some of your notes fell in the pickup and overhang bars of the 
Verse section, but they are nonetheless part of the Verse.

If you want to make a linear recording that plays back at the same time as your "Verse" and "Chorus" 
sections, you can do the following.    First, type Alt-W-2 to bring the Arrangement window to the front 
again.    Choose "New Section" from the Song menu.    Name the section "Linear." The name "Linear" 
appears at the bottom of the sections list on the left side of the arrangement window.    Drag the "Linear" 
section out onto the second row of the arrangement window starting at bar 1.

The “Linear” section now has a red bar over it, indicating that it has become the record-enabled section. 
Click the rewind and play buttons, and begin recording notes into this section. When you reach the end of 
the section, it will simply grow to the right as you keep playing. The graphic editing window will show the 
new notes that you have recorded, overlapping notes that are simultaneously playing in the Verse and 
Chorus sections. The linear section can grow to accommodate the notes you play because there are no 
other sections in the way to the right of it on row 2. In the previous example when we were recording into 
the “Verse” section it didn’t grow because the “Chorus” section was immediately following it in row 1.



Tutorial: recording into a section (7 of 14)

Smooth Record Loop
Smooth Record Loop causes FreeStyle to take notes in the bar preceding the record loop and duplicate 
them just before the end of the record loop so that you don’t hear a gap in the music when it repeats. 
Notes that are duplicated automatically when this option is turned on are indicated by a cross within the 
note as shown below.



Record Menu
Smooth Record Loop
When Smooth Record Loop is turned on, notes that are recorded in the pickup bar are automatically 
played at the end of the record loop. Often when you record a loop, you play pickup notes into bar one, or
you play notes on the down beat of bar one a little bit early. In either case, these notes are not actually in 
the loop because they occur before beat 1 of the first measure. As a result, they do not play when the 
section loops back to the first measure. Smooth Record Loop automatically places pickup bar notes at the
end of the loop so that they seamlessly lead into the beginning of the loop when it repeats. If you hear a 
“gap” when the section repeats, try turning on Smooth Record Loop; most likely, the “gap” effect will go 
away. Smooth Record Loop is a checkable menu item. Check it to turn it on; uncheck it to turn it off.



The Ensemble Palette (8 of 14)

Soloing a player
Click the solo button to solo a player.



Song Menu
The commands in the Song menu deal with sections and songs.

New Song
Delete Song
Rename Song
New Section
Delete Section
Rename Section
Duplicate Section
Previous/Next



Synchronizing FreeStyle (8 of 8)

Song Position Pointer
In addition, many devices send Song Position Pointer data. These messages set the current location for 
playback, much like setting the Counter in FreeStyle.



Songs (1 of 9)

Overview
A Song is created in the Arrangement window by placing sections along a time line. There is no limit to 
the number of songs you can create in a FreeStyle document, so you can try many different versions of 
the same song.

Creating a song
Building a song in the Arrangement window
The primary song structure row (top row)
Changing section lengths in the Arrangement grid
Viewing a song in the Graphic editing and Notation views
Selecting a section in the Arrangement grid
Record-enabling a section in the Arrangement grid
The Scissors and Glue buttons



Synchronizing FreeStyle (4 of 8)

Start on any clock
When Start on any clock is checked, FreeStyle will automatically start if it receives a time clock even if no 
start or continue command was received. This option is necessary when using some early MIDI devices 
which don’t send start or continue commands, only timing clocks.



Synchronizing FreeStyle (7 of 8)

Start, Stop, and Continue
Most devices that generate MIDI beat clocks also send Start, Stop, and Continue messages; slave 
devices will start playback, pause, rewind, or play from the current location according to the combination 
of these messages received.



Setup Menu
Straighten Swing
When the Straighten Swing command is checked, FreeStyle notates swung rhythms in straight time 
instead of writing them as triplets. For example, swung eighth notes are customarily written as straight 
eighth-notes. If you are playing jazz, swing, hip-hop, be-bop, or any type of music that involves a swung 
feel, check this menu item to avoid seeing triplet markings in the notation.





Setup Menu
Studio Setup
Displays information about the MIDI hardware you are using with FreeStyle. For complete information 
about this window, see the installation booklet that accompanies the FreeStyle manual.



Quantizing (5 of 5)

Swing
The swing setting affects every other grid-point, either pushing towards the next grid point, or pulling back
towards the previous grid point. Swing is useful for creating jazz and hip hop feels.

0% swing leaves every other grid point unaffected (no swing).

100% swing pushes every other point all the way to the next grid point. 

-100% swing pulls every other point back to the previous grid point. 

33% swing pushes every other point one-third of the way to the next point. This is a common 
setting for jazz swing feels.



Setup Menu
Sync
The sync command allows you to synchronize FreeStyle with other MIDI devices, such as a drum 
machine or hardware sequencer, using standard MIDI beat clocks.



Synchronizing FreeStyle (1 of 8)

Overview
Synchronization allows a drum machine or other sequencer to play along precisely with FreeStyle. You 
can also do it the other way around and make FreeStyle follow the drum machine. In either case, the two 
will remain tightly in sync. They will start, stop, rewind, and locate together, and their playback won’t drift 
over time.

The Sync command
Beat clock ratio
Start on any clock
First clock is time 1
MIDI Beat Clocks
Start, Stop, and Continue
Song Position Pointer



Tips & troubleshooting (10 of 12)

Technical support
Registered users who are unable, with their dealer’s help, to solve problems they are encountering with 
FreeStyle may call our technical support line. The tech support number is (617) 576-3066, and is staffed 
Monday through Friday 9 AM to 8 PM, Eastern Time. Our 24-hour tech support fax number is: (617) 354-
3068. We also provide on-line technical support at techsupport@motu.com and MotUTec@aol.com. For 
down-loading services on Compuserve, see our CompuServe forum in Section 12 of the MIDI Vendor C 
Forum. For down-loading services on AOL, visit our forum, which can be accessed with the keyword 
MOTU.

If you decide to call, please have this manual at hand, and be prepared to provide the following 
information to help us solve your problem as quickly as possible:

> The serial number of the program. This is printed on the cardboard page (at the front of the 
manual) which holds the registration card. Be sure to retain this page in the manual for your
reference. You must be able to supply this number to receive technical support.

> A brief explanation of the problem, including the exact sequence of actions which cause it, 
and the contents of any error messages which appear on the screen. It is often very helpful 
to have brief written notes to refer to.

> The pages in the manual which refer to the parts of the program which you are having 
trouble with.

We’re not able to solve every problem immediately, but a quick call to us may yield a 
suggestion for a problem which you might otherwise spend hours trying to track down. 



Test Button
Click a device's icon and then click the Test button to see if MIDI data from FreeStyle is successfully 
making it to the device. If so, you should hear the device play a chord when you click the Test button. 
FreeStyle sends the chord on MIDI channel 1.

Remember, you need to select the device first by clicking its icon.



Text Menu
The text menu commands operate in standard Windows fashion on text entered in the notation view. They
work with all text, including measure numbers, section names, page numbers, titles, headers, footers, and
so on. Each command is briefly explained below.

Text Settings
Insert Page Number
Insert Part Name
Fonts



Text Menu
Text Settings
If you make selections in the text menu while text is selected, you will affect the selected text. You can 
also control the appearance and placement of text you are about to enter by changing the settings when 
no text is selected.

Style
This menu item provides the standard text styles (bold, italic, underline, etc.)

Justify
Aligns text along the left edge, center, or right edge of its text box.

Pages
This text setting determines what pages the text appears on. You can apply it to a text box in the same 
manner as point size, text style, and justification. For example, the title might be given the First Pages 
setting, but a page number might be given the Body Pages setting. If an item is grayed out, it is because it
does not apply to the situation; for example, if the notation window is currently displaying a left-hand 
page, the Right Pages command is grayed out. See the table below for a summary.

When choosing which pages to display text on, keep in mind that FreeStyle has two separate text layouts 
in the notation view: one for instrument parts (used when any player is displayed by itself) and another for
scores (viewing multiple players together). When you display a single player by itself, FreeStyle displays 
the single-player text regardless of what player is being shown (except for the player’s name, which 
changes to show the correct instrument name).

Page setting: Where text appears: Examples:
This Page Only Text appears on the page you insert it; FreeStyle even 

makes note of the player(s) currently showing when you 
choose this setting and will only display the text when that 
combination of players is present.

Special instructions for an individual 
player or section

First Pages Text appears on the first page only. Grays out when you 
are viewing any page other than the first page.

Title, composer, copyright notice

Body Pages Body page are all the pages after the first page. Therefore,
text appears on all pages except the first page. Grays out 
when you are viewing the first page.

Headers, footers, page numbers, 
instrument part names

Left Pages Text appears on left-hand pages only, starting with page 2.
Grays out when you are viewing the first page or a right-
hand page.

Headers, footers, page numbers, 
instrument part names

Right Pages Text appears on right-hand pages only, not including the 
first page. The first right-hand page (excluding page 1) is 
page 3. Grays out when you are viewing the first page or a
left-hand page.

Headers, footers, page numbers, 
instrument part names

All Pages Text appears on every page, including the first page. Headers, footers, page numbers, 
instrument part names, copyright 



notices



Window Menu
The Controls Palette
When this menu item is checked, the Controls palette appears as a floating window.



Window Menu
The Currently Open Documents
The bottom of the Window menu displays the name of all currently open documents, along with their 
Arrangement window. Each document has one Graphic/Notation Editing window and one Arrangement 
window.



The Ensemble Palette (4 of 14)

The currently record-enabled player
To record-enable a player, click the record button next to the player’s name so that it lights up. Only one 
player can be record-enabled at a time. In addition to recording, many things you do in FreeStyle depend 
on the currently record-enabled player—anything, if fact, that has to do with a specific player or take.



The Ensemble Library (1 of 1)

Overview
In the same way that it would be tedious to re-enter all your player settings every time you created a 
player, it would be annoying to have to add your favorite players one at a time to each new document. 
FreeStyle has a short-cut: The Ensemble Library.

An Ensemble Library Entry is a collection of player templates that can be added to a document in one 
shot. Whenever you create a document, FreeStyle asks you to pick an ensemble library entry. It then 
creates players from each of the player templates in the ensemble. 

The Edit Ensemble Library command in the Setup menu lets you setup and modify your own Ensembles.



The Ensemble Palette (1 of 14)

Overview
When you make music with FreeStyle, you do it with players in an ensemble. The Ensemble Palette 
shows you a list of all the players in a FreeStyle document. Each FreeStyle document has one ensemble. 
If several FreeStyle documents are open at that same time, the Ensemble palette shows the players for 
the document that is currently in front.

Players
Player info
The currently record-enabled player
Working with takes
Changing a player name
Choosing a playback sound for a player
Soloing a player
Muting a player
Showing and hiding a player
Changing a player's color or pattern
Changing a player's volume and pan settings
Rearranging and resizing the columns
Resizing the Ensemble palette to conserve screen space



Window Menu
The Ensemble Palette
When this menu item is checked, the Ensemble palette appears as a floating window.



The Move palette (1 of 1)

The move palette lets you shift events in time. You can choose to offset the events from their current 
location, or to have the music start at an absolute location.

The time fields let you specify either an absolute time location (if “Move To” is selected) or an offset. Ticks 
are 960ths of a quarter note.

By checking “move a copy” you can quickly replicate a piece of music, shifted by any amount of time.



Page layout (3 of 10)

The Page Layout dialog
Choose “Page Layout” from the “File” menu to get the Page Layout dialog. It gives you control over 
margins and other page layout settings.



The Player Library (1 of 4)

Overview
Players are one of FreeStyle’s fundamental building blocks. A player has a lot of control over its music, 
from how it sounds to how it is displayed in the notation view. Since it would be tedious to set up all this 
information each time you create a new player FreeStyle gives you a powerful short-cut: The Player 
Library. The player library stores commonly used “Forms” or “Templates” that you can use to create 
Players from.

You can think of a Player Template as a “Rubber Stamp” for creating Players. Extending the metaphor, if 
you modify a rubber stamp, it does not affect “prints” that have already been made with it, only the ones it 
will make in the future. If you modify a print, it does not change the stamp, or any other prints. Player 
Templates work the same way. Changing a Player Template does not affect Players that have already 
been made, only ones that you make from that point forward. Similarly, modifying a Player, either in the 
Ensemble window, or in the “Edit Player Info” dialog does not affect the Player Template it was created 
from, or Players in other documents.

To summarize, a Player Template is a “stamp” that you can use to create a Player. After the Player is 
created it is no longer tied to the Template that created it in any way.



Songs (4 of 9)

The primary song structure row (top row)
The top row is the Primary Song Structure row. If you have sections named verse, chorus, etc. put them 
in the top row because doing so causes their names to appear in the Graphic Editing view time line and 
above each staff system in the notation view. Sections containing fills, solos, or other material should go 
in the rows below.



Songs (9 of 9)

The Scissors and Glue buttons
The scissors button snips the selected section in the Arrangement grid into two pieces at the nearest 
barline to the playback wiper. The Glue button glues the selected section in the Arrangement grid to its 
right-hand neighbor on the same row. The selected section must be touching its right-hand neighbor.



Notation view (10 of 12)

The shaded border in the notation view
The shaded border reflects the print area of the page: the shaded area will not print. Its size is determined
by the printer you are using (whatever is currently selected in the Printer Setup command in the File 
menu).



Synchronizing FreeStyle (2 of 8)

The Sync command
To get sync going, choose Sync from the Setup menu. Implementations of MIDI have evolved over the 
years. As a result, not all devices transmit and send MIDI clock signals in the same way. FreeStyle 
provides several options for maximum synchronization compatibility with your master device. The default 
settings reflect the most commonly used MIDI standards. It is best to leave them set this way unless you 
experience problems when synchronizing.

For more information on the settings in the sync dialog, use the browse buttons (>> and <<) to view the 
rest of the topics in this sequence.



Window Menu
Tile
This command places all of the currently open document windows next to each other, fully visible (in the 
standard Windows fashion), so that you can conveniently access any window.



Window Menu
Tile Palettes Left
Arranges the windows on the screen with the Controls and Ensemble palettes along the left edge of the 
screen and the Graphic Editing/notation window on the right.



Window Menu
Tile Palettes Top
Arranges the windows on the screen with the Controls and Ensemble palettes along the top of the screen 
and the Graphic Editing/notation window below them.



Quantizing (4 of 5)

Time offset
The time offset slider lets you shift the whole grid forward or backward in time. This lets you give your 
music a “pushed” or “laid-back” feel. Moving the slider to the left makes each grid point fall a little early; 
moving to the right makes each grid point fall a little late.



Tips & troubleshooting (1 of 12)

Overview
These topics cover several common problems people experience with FreeStyle.

Can't access the right sounds in your MIDI instrument
The display seems to stall and skip
Importing Standard MIDI Files
Unable to record or play anything
You can't open FreeStyle
If you hear "flanging" during playback
Send in your registration card!
Disk Repairs
Technical Support
Sending in your suggestions
Getting Updates



View Menu
To Fit
Fills the window with the currently selected region of notes. If nothing is selected when you choose this 
command, FreeStyle zooms out to show as much section or song as possible.



Setup Menu
Toggle Metronome
Turns the metronome off when it is on, or turns it on when it is off. In other words, this command toggles 
the metronome on or off, depending on its current state.



Record Menu
Toggle Record Loop
Turns the Record Loop on and off. The Record Loop is any part of a section or song that you specify to 
repeat indefinitely with the Set Record Loop command. It appears as two repeat barlines in the rulers. If 
the Record Loop is currently turned off, the repeat barlines are not visible; the Toggle Record Loop 
command makes them appear. If the Record Loop is on, Toggle Record Loop turns them off.



Transmit Channel
Indicate the MIDI channels on which the device transmits MIDI data here.



Region Menu
Transpose
Changes the pitch of all currently selected notes as specified by the settings in the Transpose window. 
Specify the interval by which you wish to transpose by selecting one of the twelve chromatic intervals 
provided. To Transpose by more than one octave at a time, choose an octave setting of 1or higher. To 
transpose by an interval of less than an octave, set the octave option to zero.



Transposing (1 of 6)

Transposing
There are five ways to transpose notes in FreeStyle.    They are explained by example in the following 
sections.

Transposing while recording
Automatic instrument transposition
Transposing pitch without changing key signature
Changing key signature without transposing pitch
Transposing pitch and changing key signature at the same time



Tutorial: recording into a section (13 of 14)

Transposing & bass parts
If you ever need to record a player whose note range falls outside the range of keys on your MIDI 
keyboard, you can get FreeStyle to automatically transpose your controller up or down an octave so that it
plays the octave appropriate for the instrument. This feature is provided in the Edit Player Info command 
in the Setup Menu. 



Transposing (6 of 6)

Transposing pitch and changing key signature at the same 
time
Suppose you played a Piano part in the key of C and decide later that you would like to hear it in the key 
of D. In this case you want to change the key signature and also transpose the pitch of every note up by a
full step. This is a two-step operation in FreeStyle: change the key and transpose the notes. See the 
Transposing pitch without changing key signature and Changing key signature without changing pitch for 
how to do each step. Of course, if you are only working in the graphic editing view you don’t have to 
bother changing the key signature until you want to display or print music notation.

If you are transposing your entire song, be sure that you don’t select any notes in drum parts, or your 
drum sounds may change in unexpected ways. 



Transposing (4 of 6)

Transposing pitch without changing key signature
You can accomplish this task in FreeStyle in one of two ways. First, you can just select the notes you 
want to change and drag them up or down in the graphic editing or notation view to change pitches. Or, 
you can select some notes and use the Transpose palette. To make the Transpose palette appear, 
choose “Transpose” from the Region menu. Adjust the settings in the window and click the Transpose 
button to offset the pitches of all selected notes by the desired amount. If you don’t have any notes 
selected, the Transpose button won’t do anything.



Transposing (2 of 6)

Transposing while recording
Suppose you want Bass notes to be recorded one octave lower than where you play them on your 
keyboard. Record-enable the Bass player in the ensemble window by clicking on the record button to the 
left of the name “Bass.” Then choose “Edit Player Info” from the Setup menu. Set the “Transpose 
Recording” edit field and popup so they say “1 Octaves Down.”



Setup Menu
Turn All Notes Off
Silences any notes that are currently playing. This command is helpful when notes get “stuck” on.



Tutorial: recording into a section (1 of 14)

Tutorial: recording into a section
The topics that follow tell you how to control FreeStyle’s recording features with the mouse. You can also 
use the computer keyboard, and even the keys on your MIDI controller, for all of the essential steps in the 
recording process, from choosing a section to controlling FreeStyle’s transport controls. 

The tutorial makes more sense if you view your music in the graphic editing view instead of the notation 
view.    If you want to leave this help window open while you do the tutorial, remember to click back on the 
editing window before attempting to use menu commands.    Many menu commands are greyed out when 
this help window is frontmost.

To begin, go to the File menu and choose New to open a new blank document. FreeStyle will ask you to 
choose an Ensemble. Choose Rock Band and click OK.

Name the Section
Record Loop
Record menu options
Wait for Note
Auto Loop Record
Smooth Record Loop
Follow Song
Set the tempo and metronome
Record a Take
Keep the music going
Keep Recording & drum parts
Transposing & bass parts
Recording into another new section



Tutorial: recording into a song (1 of 4)

Making a song to record into
After you have recorded several sections, you are ready to make a song. Choose “New Song” from the 
song menu and enter the name “My Song.” The FreeStyle Arrangement window will appear. On the left is 
a list of all of your sections -- if you have been following this tutorial, you’ll only have two of them. Type the
letters “a-b-a-b” in succession to quickly place your first two sections onto the arrangement grid. Or, if you 
prefer you can drag each section from the list on the left to a position on the grid to the right. For now 
make sure you put sections in the top row of the grid, which is the “primary song structure row.”

First click on the rewind button and then on the play button in the control palette to hear your song. (If the 
wiper loops in bar zero, turn off “Wait For Note” in the Record menu or click on the record button in the 
control palette to turn off recording.)

Record into the song
Single-section recording within a song
"Follow Song" recording



Page layout (2 of 10)

Two separate page layouts: instrument parts and scores
FreeStyle provides two separate page layouts for a document: a single-player layout for instrument parts 
(used when any player is displayed by itself) and a score layout for scores (viewing multiple players 
together). For example, you might have different text, staff sizes, and margin settings for individual 
instrument parts than you do for the score. To view and work with the score layout, simply show two or 
more players. To view the single-player layout, show only one player (it doesn’t matter which one).



Tips & troubleshooting (5 of 12)

Unable to record (or play) anything
If FreeStyle starts correctly, but you are unable to record (or play) anything, double-check your cable 
connections and synthesizer settings. Also make sure the settings for the device are correct in the Studio 
Setup command in the Setup menu. 



Edit Menu
Undo
Takes back the last action you made in FreeStyle. Anything having to do with recording and editing the 
music can be undone. Undo does not apply to things like saving, opening or closing windows, adding 
players to the ensemble, or anything that does not involve changing the music itself.



Page layout (6 of 10)

Units of measurement
You can express your margin settings and indentation in inches (in), centimeters (cm), millimeters (mm), 
or points (pt). If you don't provide units, FreeStyle will assume you mean inches.



Preferences (11 of 16)

Use patterns to display velocities
If you choose to use color, you can have FreeStyle indicate the velocity of the notes by how densely filled 
the note is. The higher the density, the higher the velocity.



Preferences (10 of 16)

Use Patterns/Colors to distinguish players
When viewing multiple players in the Graphic Editing window, FreeStyle can differentiate the notes for 
each player by displaying each player with its own color or graphical pattern.



Graphic Editing view (8 of 13)

Using cursor snapping for rhythmic precision
When dragging, you can make the cursor “snap” to a rhythmically even grid by double-clicking the arrow 
button to open the Brush/Cursor Settings. Check the Cursor snaps to grid option, and choose a resolution
from the pop-up menu. If you only want to temporarily turn on grid snapping, hold down the shift key when
you drag.



Playback loops (4 of 9)

Using playback loops to build a drum part
Here is an excellent approach for developing a drum part. Start by using a Riff Metronome so you have a 
drum beat to play to while you record your other parts. When the rest of your music is in place and you 
want to finalize your drum part, use the Become Player button in the Metronome dialog to convert your 
Riff Metronome into an editable drum player. For sections that are longer than the metronome riff, the 
Become Player button will create a playback loop for the new drum player’s current take which will repeat 
the drum riff until the end of the section. Next, override just the drum measures you want to change using 
one of the methods described below. Change the notes in the overridden measures, and you’re done!

Here are some other things to keep in mind when using playback loops: The markers that show playback 
loop definitions appear only in the graphic editing view’s time line. They aren’t visible in the notation view. 
In the graphic editing view, original notes appear with rounded edges and repeated notes appear with 
square edges. In the notation view, repeated notes are indistinguishable from original notes. 



Using Remote Controls (1 of 1)

Remote controls let you control all of FreeStyle's transport controls and recording features from your MIDI
keyboard. They are designed so that you can record an entire song from start to finish without ever 
touching your computer. You can assign a FreeStyle command to any key on your MIDI keyboard. In 
order to use the key as a remote control, you first hold down a command trigger so FreeStyle knows you 
are not just playing a note. The trigger can be a single controller, such as a foot pedal, or it can be a 
“clump” of keys that you would never want to play simultaneously while recording. You can smoothly 
switch between recording and “remote controlling” FreeStyle by pressing and releasing the trigger keys.



Graphic Editing view (2 of 13)

Using the cursor buttons
These three cursor buttons change the cursor. Use the arrow to drag and select notes. Use the 
paintbrush to draw in notes with the mouse. Use the text button (available in notation view only) to insert 
text of any kind.



Using the metronome (1 of 2)

Using the metronome
FreeStyle provides three ways to hear a metronome while you record. Recording with the metronome is 
important because it ensures that FreeStyle’s measures and beats properly match what you play. You 
have three choices for a metronome sound: a standard click sound on the computer’s internal speaker, a 
MIDI click produced by one of your MIDI instruments, such as a side stick sound on a drum machine or 
drum kit, or FreeStyle’s “Riff Metronome”.

FreeStyle’s metronome riffs are set up for a General MIDI drum kit. If necessary, you can adjust them for 
a non-GM device. Just open them in FreeStyle (using Open in the File menu), edit the notes, and save 
again as a standard MIDI file in the FREESTYL\METRONOM directory. To get rid of a riff entirely, remove 
it from the directory.

FreeStyle’s “Riff” Metronome



Graphic Editing view (3 of 13)

Using the scrolling playback wiper
The scrolling wiper indicates the current playback location. Click in the time line to move it. Drag it to 
“scrub” the music.



Notation view (9 of 12)

Using the scrolling wiper in notation
The playback wiper shows the current playback location. Drag it to "scrub" the music. Double-click 
anywhere on a staff to make it jump to that location.



Working with text (5 of 7)

Using the Text Menu
If you make selections in the text menu while text is selected (this includes measure numbers and section
names), you will affect the selected text. You can also control the appearance and placement of text you 
are about to enter by changing the settings when no text is selected. The Font, Style, and Size menu 
items operate as standard Windows text menu commands. The page menu item is unique because it 
allows you make text appear on multiple pages.

Use the Insert Page Number/Insert Part Name commands to insert special text that changes according to 
what you are viewing. Page numbers always show the number of the visible page. A part name shows the
name of the currently visible player when you are viewing only a single player. When you are viewing 
multiple players, the part name is “Score”. You must use the text tool to create a text box before you 
choose “Insert Page Number” or “Insert Part Name”. These commands insert text into an existing text 
box. FreeStyle will not let you select just part of a page number or part name, but otherwise these bits of 
text act just like any other word in a text box. You can cut, copy, paste or delete them, and change their 
font, size, and style just as with any other text.



View Menu
The View menu provides several useful options for how information is displayed in    FreeStyle. It lets you 
show and hide various items in the program to help keep things clear, and it also has all of the zooming 
commands, which give you a bird’s-eye view of your music, enlarged detail, or anything inbetween.

Controllers
Hide/Show Loop Markers
Hide/Show Section Names
Hide/Show Rewind Marker
Place Rewind Marker
Zoom...
Zooming Shortcuts



Songs (6 of 9)

Viewing a song in the Graphic editing and Notation views
The graphic editing and notation views can show an entire song as easily as a single section. Just choose
the song from the pop-up menu in the upper left-hand corner of the window. The only difference is that in 
a song, you see all of its sections at once. Remember, sections in the top row of the Arrangement window
grid appear by name in the time line, and their boundaries are indicated in the note grid by heavy vertical 
lines. In the Notation view, their names appear above each staff system. While viewing a song, you can 
rename it or get rid of it using the commands in the Song menu.



Choosing what to record into (5 of 5)

Viewing the current record target
The current place where recording will occur (the 'record target') is displayed in the Control palette for 
your convenience under the heading “Record Target”.



Tutorial: recording into a section (5 of 14)

Wait for Note
Wait for note causes FreeStyle to repeatedly cycle in the pickup bar until you play your first note. If you 
plan to play pickup notes or anywhere near the downbeat of measure one, Wait for note works well. If you
plan not to play until a few beats past the measure 1 downbeat, turn it off.



Record Menu
Wait for Note
When you start recording, Wait for Note causes FreeStyle to repeat measure zero indefinitely until you 
play the first note. After the first note is received, FreeStyle continues on into measure 1 the next time it 
reaches the end of measure 0. You can play notes anywhere in measure 0 as pickup notes to the section.
FreeStyle is also intelligent about notes played a little past the downbeat of measure 1 and will adjust 
these notes to their correct position instead of putting them at the very beginning of the pickup measure. 
Wait for Note is a checkable menu item. Check it to turn it on; uncheck it to turn it off.



Unknow Devices 
What to do for MIDI devices that do not appear in FreeStyle’s list
First of all, don’t despair. You can use FreeStyle with any MIDI-equipped multi-timbral sound module, 
keyboard synthesizer, or other MIDI sound source.

If you have a MIDI device that doesn’t appear in the Studio Setup drop-down list, this only means that 
FreeStyle isn’t yet customized to support that specific instrument. This means a little bit of extra setup on 
your part. But Once the device is set up, you will be able to choose sounds from it in FreeStyle just as 
easily as devices that FreeStyle knows about.

To set up a device that doesn’t appear in the drop-down list:

1. Choose the Other category in the drop-down list.

The device name will change to “Device 1”.

2. Click the expand icon ( + ) to the left of the device name, and then click the additional expand icon to open the 
Details section.

3. In the “Name” section, rename the device as desired.

4. In the “Transmit” and “Receive” sections, indicate the MIDI channels on which the device sends and receives MIDI 
data.

5. In the Properties drop-down list, check the device properties that apply to your device.

This step is important because it determines how FreeStyle will interact with the device.

6. If the device is a General MIDI (GM) device, be sure to indicate this by checking the General MIDI device property.

This lets you access all of the GM sounds by name from within FreeStyle.

7. Choose the “Does not accept program changes” property if any of the following are true:

>> The device has no built-in sounds (such as a sampler).

>> You prefer to access specific MIDI channels on the device, rather than choosing sounds 
by name and letting FreeStyle dynamically allocate MIDI channels.

>> You frequently change the bank(s) of internal sounds in the device and therefore need to 
be able to set up sounds on a per-channel basis.



What to do if you see a generic sound list

If you see a generic sound list with names like “Patch 1” and “Patch 2”, you have several choices.

One choice is to just use the generic sound names. The patch numbers refer to the MIDI program change
number for each sound in the MIDI instrument. All you have to do is find out what the MIDI program 
change number is for the sound you want to choose. For some devices, this is easy because of the way 
they work or because the program change numbers are easy to find in the user’s manual.

In the meantime, contact Mark of the Unicorn regarding your instrument and we’ll gladly add it to our list 
of devices to support in future updates of FreeStyle. For information on contacting Mark of the Unicorn by 
phone, fax, or e-mail, see Technical support.

If you consider yourself to be somewhat of a “hacker”, you can create your own custom sound list. Doing 
so involves editing text files in the freemidi directory that provide device information and sound names to 
FreeStyle.

To create a custom sound list for your MIDI instrument, open and read the following text files (located in 
the freemidi directory located in your Windows directory), which contain instructions at the beginning that 
tell you how to create your own device definitions and sound name lists:

n freemidi\defnames\readme.text

n freemidi\devices.ini

n freemidi\defnames.map

 



What to do if you see MIDI channels instead of a sound list

Earlier, in the Studio Setup window, you indicated that you have a sampler or other device with no built-in 
sounds, and you chose the Does not accept program changes device property for it as explained in What 
to do for MIDI devices that do not appear in FreeStyle’s list. You also specified a range of MIDI channels 
that the device can receive MIDI data on. In this case, the sound pop-up menu displays the list of MIDI 
channels.

When you use MIDI channel assignments like this instead of sound names, FreeStyle does not employ 
dynamic channel allocation during playback for the player. Instead, it always uses the channel you’ve 
chosen for the player. This is ideal for situations where sounds cannot be called up on an instrument 
using MIDI program change events. It is also the only way to override FreeStyle’s dynamic channel 
allocation, which you may want to avoid for other reasons.

To assign a sound in the sampler to a player in the Ensemble palette, a player template in the Player 
Library, or a riff in the Metronome dialog box, set up the sampler so that it will play the sound on a specific
MIDI channel, and then assign the player to that same channel.



Notation view (3 of 12)

What you see is what you get
FreeStyle’s notation view is a WYSIWYG (what you see is what you get) page view: what you see on the 
screen is exactly what you will get when you print. Music is automatically placed on as many pages as are
necessary. FreeStyle manages the note spacing, measures widths, and staff spacing so that musical 
symbols never collide.



Window Menu
The Window menu provides a number of convenient features that help you manage FreeStyle’s windows 
and palettes.

Cascade
Tile
Tile Palettes Left
Tile Palettes Top
Save Window Layout
The Controls Palette
The Ensemble Palette
The Currently Open Documents
Arrangement Window



Graphic Editing view (4 of 13)

Working with    the pitch ruler to determine pitch
The pitch ruler shows you the pitch of the notes. (Middle C is C3.) Keys animate during playback, just like 
a player-piano. Click the keys to hear the pitch (using the instrument played by the currently record-
enabled player). Ctrl-drag to magnify a range of notes. Double-click a key to select all notes of that pitch. 
Alt-drag to select all notes within a range.



Controllers (6 of 7)

Working with note-on velocities
Note velocities (their initial volume when they are first played) appear as vertical bars. You can shape 
them with the pencil, curve, and line tools.



The Ensemble Palette (5 of 14)

Working with takes
A take is a place to record a single player’s part in a specific section of music. The current take for each 
player is displayed next to the player in the Ensemble window. Recording always takes place into the 
current take (for the currently record-enabled player), even if there is already music in the take. FreeStyle 
never erases existing music when recording new music. Each player can record an unlimited number of 
takes. Each player has a different set of takes for each section of music (Intro, Chorus, Verse, etc.) To 
view takes for a section, choose the section from the pop-up menu in the Graphic Editing/Notation 
window.



Working with text (1 of 7)

Working with text
FreeStyle automatically provides measure numbers and section names for you. When viewing or printing 
more than a single player, FreeStyle will also automatically provide staff names for each player. But you 
needn't stop there: you can add any other text that you like using the Text Tool. You can add titles, 
subtitles, the composer, instrument part names, headers, footers, page numbers, copyright notices, and 
other text in standard Windows fashion as discussed in the following topics.

Inserting text
Selecting text
Changing the font, size, style, etc.
Using the Text Menu
Adding a part name to all parts
Adding page numbers



Yamaha    
RM50
Setup the RM50 for FreeStyle by enabling a Device ID number. To do so, press the Utility button and then
the Page buttons until you see the_______8ge. Press +1/Yes. Press the Page buttons until you see the 
Device number page. Enter a number. A value of 1 (one) will work fine unless you have more than one 
RM50 on the serial port, in which case you should give them each unique numbers. Do not use the ALL 
setting.

TG100
No specific preparations are necessary to use this device with FreeStyle.

TG500
FreeStyle puts the TG500 into Multi mode automatically. For best results, do not change modes on the 
TG500 manually.

TX81Z
No specific preparations are necessary to use this device with FreeStyle.



View Menu
Zoom
These commands control the magnification level of the note grid and notation display. FreeStyle has a 
wide range of zoom levels, from a bird’s-eye view to a very enlarged display. Use the following commands
to quickly change the zoom level. FreeStyle has many levels of magnification. When zooming around, you
can jump directly to a particular setting, or gradually zoom in or out one setting at a time. The zoom 
commands in the menu affect time and pitch zoom levels simultaneously. You can zoom just time or just 
pitch in the graphic editing view by using the zoom sliders.



Graphic Editing view (11 of 13)

Zooming in to increase accuracy
To magnify a portion of the note grid, hold down the Ctrl key and drag over it. This is great for detailed 
work. To return to the previous magnification, choose Zoom Back from the View menu. You can also 
zoom using the zoom controls at either end of the scroll bars.

              



View Menu
Zooming shortcuts
FreeStyle has the following shortcuts for zooming:

Ctrl-drag in the time line or controller strip

Fills the display horizontally with the region of time you select.

Ctrl-drag in the pitch ruler

Fills the display vertically with the range of pitches you select.

CtrlShift click anywhere in graphic editing or notation display

Zooms back to the previous zoom setting (just like Zoom Back).

Ctrl-drag a selection box over any portion of the graphic editing or notation view

Fills the window with the region you select.






